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Preface

Welcome to the 4™ Dimension.

From the time of its release in the mid-1980’s, 4D has been winning
awards from the computer industry press and winning praise from
users for its power, elegance, and simplicity. Millions of users and
developers all around the world are using 4™ Dimension to store data
that is vital to their organizations.

What is the 4" Dimension? Albert Einstein, the great physicist, helped
the world to see that Time is the fourth dimension. The name of our
product is not a coincidence. Throughout six major versions and
several dozen updates, the authors and publishers of the 4D family of
products have held steadfastly to our mission—giving you, the user,
the power to accomplish more, in less time.

As the first major graphical user interface relational database product
on the Macintosh, 4™ Dimension pioneered the concept of RAD—
Rapid Application Development. Now, with Version 6, we have taken
Windows® and Macintosh™ RAD to a whole new level.
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Preface

The tutorials in Discover 4™ Dimension use the example of a personal

music collection to build and work with a database. In the next two
hours, using 4" Dimension and the tutorials, you will do all of the
following:

= Create a relational database to track your personal music collection.
= Create custom Input and Output forms to view the data.

= Import several hundred records of sample data.

= Create and save your own custom queries.

= Create a custom report to print a list of your albums.

= Design your own labels for your CD holders.

= Print three-dimensional charts to analyze your collection by type of
music.

= Create a multi-window, custom menu environment for your database.
= Create Web-enabled forms for viewing the data on the Web.

= Publish the database on the World Wide Web.

What is most remarkable is the fact that you will do all of this in
4™ Dimension, without using any add-on products, and by writing
only two lines of programming code!

After you finish the tutorials, you will also find out how you can add
even more power to the application—debug it; cross-reference it;
compile it; serve it to multiple users; embed word processing,
spreadsheet, and drawing functions into it; and connect it to back-end
SQL databases—all with tools from the 4D family of products.

4th

Welcome to the Dimension.
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About Discover 4" Dimension

About Discover

How to Use the
Tutorials

Tutorial Database

Assumptions

h L3 o

4" Dimension

The four chapters in this manual are tutorials—step-by-step
explanations—that show you how to use 4™ Dimension to create
useful databases. As you work through these tutorials, you will become
familiar with many of the major features of 4™ Dimension.

It should take you no more than two hours to work through all the
chapters. When you have finished Discover 4" Dimension, you can start
building your own 4™ Dimension databases.

You should work through the tutorials in order; the work you do in
each chapter prepares the database for the work that you will do in the
next. Each chapter begins with an estimate of how long it will take you
to complete the work in it. Feel free to stop at the end of any chapter,
take a break, and begin the next chapter by opening the database on
which you have been working.

We have provided “progressive copies” of the tutorial database. The
copy labeled “Chapter2” picks up at the beginning of Chapter 2;
“Chapter3” picks up at the beginning of Chapter3; and “Chapter4”
picks up at the beginning of Chapter 4. If you misplace your work in
the middle of the tutorial, you don’t have start over; just launch the
appropriate progressive copy and continue to follow the tutorial.

This manual assumes that you have already installed 4™ Dimension as
described in the Installation Guide, and that you are ready to create a
new database of your own.

Discover 4t Dimension ix



Preface

Conventions

Steps and
Explanations

This manual uses certain conventions to help you understand the
material.

The tutorials provide specific steps for you to follow, as well as general
information that explains 4™ Dimension. The format for steps and
explanations looks like this:

A numbered step tells you what to do.

Following the numbered step, there may be a paragraph that offers an
explanation or a comment.

Type “Smith” in the Last Name field.

A numbered step can contain the following special notations:

Notation

Example Meaning

Quotation Marks | Type “Smith” When a numbered step asks you to type

something, the characters you should type
are enclosed in quotation marks.Type
exactly what is enclosed in the quotation
marks, including any spaces or
punctuation; however, do not type the
quotation marks.

Underline

in the Last Name The underlined text tells you where to do
field. something. You should locate that object
or menu on the screen, and do what the
step describes.

Database Terms

X

All table names are shown in brackets in the text to help distinguish
them from the names of fields, forms, and other items. For instance,
the Albums table is written as the [Albums] table.

Discover 4t" Dimension




Conventions

Other Notation

Note

4D Server

Cross-Platform
Considerations

The tutorials also use the following explanatory notes:

Text emphasized like this provides annotations and shortcuts that will
help you use 4" Dimension more productively.

Throughout the manual, 4™ Dimension and 4D Server/4D Client are

referred to simply as 4™ Dimension. Differences between the operation
of the two products are explained in 4D Server notes, which provide
information about using 4D Server/4D Client. This information is
provided only when the operation of 4D Server/4D Client differs from
that of 4" Dimension.

Notes like this alert you to important pieces of information and alert
you to situations where data might be lost.

In this manual, the names 4™ Dimension and 4D are used
interchangeably.

This manual explains the use of 4" Dimension on both the Windows®

and Mac™OS (Power Macintosh) platforms. Although the concepts
and functionality of both versions of 4™ Dimension are nearly
identical, the manual addresses any differences where necessary. Such
differences may include the graphical user interface and keyboard
commands.

The screen shots illustrate 4" Dimension in the Windows 95
environment. The two versions of the same screen are only presented
if there are any major differences between them.

This manual assumes that you are familiar with basic Macintosh or
Windows operations, such as selecting objects, choosing menu items,
clicking, dragging, and so on. For complete information and
instructions, refer to the user guide or the on-line help that came with
your computer.

Discover 4t Dimension Xi
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Creating a Database
with 4D

Estimated time to complete: 30 minutes

In this chapter, you will learn how to design a database using

4™ Dimension. You will also learn some of the database terminology,
such as table, field, query, and index. When you have finished this
chapter, you will know how to do the following:

Create a table, create fields, and change the properties of fields.
Create default input and output forms.

Create standard choice lists.

Enter new records and modify existing records.

Import records from a document on disk.

Find records in your database.

Index fields to improve search performance.

This chapter assumes that you have already installed 4" Dimension as
described in the Installation Guide, and that you are ready to create a
new database of your own.

Discover 4th Dimension 13



Chapter 1 Creating a Database with 4D

Creating a New Database

14

» To create your Music Collection database in 4™ Dimension.
1 Launch 4D.exe (Windows) or 4th Dimension (Macintosh).

You can double-click 4" Dimension, or select the 4th

application and choose Open from the File menu.

Dimension

4D displays the Open Database dialog box, allowing you to create a
blank database or to open an existing database.

@Dpen Database

[¥ Create Database Folder

p ‘-9. ' Open an Existing Database

Other... [t |
=
[

o | [oc ]

Keep the options Create a Blank Database and Create Database Folder
checked and click OK.

4D prompts you to name your new database.

Type the file name “MyMusic”.

4 Click the Save button.

Your 4 Dimension database is created in a folder called “MyMusic”. It

will be composed of four files on Windows and two files on Macintosh.

Macintosh Windows Description
MyMusic MyMusic.4DB | Structure file containing forms, tables,
methods...
- MyMusic.RSR Part 2 of the structure file on Windows
MyMusic MyMusic.4DD | The data file containing data and
indexes
- MyMusic.4DR | Part 2 of the data file on Windows

Discover 4t" Dimension



Creating a New Database

You are now ready to begin building your database. When you create a
new database, as you have done here, 4™ Dimension opens in the
Design environment and the User environment simultaneously.

The structure window—part of the Design environment—is the
frontmost window on the screen. This is the window in which you
create the structure (the tables and fields) of your database.

vt 4th Dimension |- O] x]
Flle Edit Use Design Iook Stuctue Help
Toolbar — as|mlg| @02 e == 2R ) =]
[ 5twucture for MyMusic.4DB M=
= =
Table name Tabiz 1 -
Structure window ———— bd to list the records of: Table 1
EIN| vz

User Environment
window

| oz

As you work through the exercises in this manual, you will become
familiar with both the Design and User environments and discover
how easy it is to switch between them. For now, we will concentrate on
the Design environment.

Discover 4th Dimension 15



Chapter 1 Creating a Database with 4D

Creating a Table

Naming the Table

Creating Fields

Now you are ready to create your database structure. In the structure
window, note that 4" Dimension has created a default table and
named it Tablel.

This first table will store album information, so you should rename the
table to something more descriptive of its contents. We will call this
first table [Albums].

To change the name of this table to Albums.

Double-click the table name Table1 in the Structure window.
The Table Properties dialog box appears.

Privileges | Triggers | Color |
- T able nam

[Tabled

-Record Access

Load: All Groups
Save: Im
Add [NGowes =]
Delete: Im

- T able Access

Cwrer IAII Groups - l

Dione | Apply I

Highlight the name Table1 and replace it with the name “Albums.”

For information about the other options in the Table Properties dialog
box, see the 4" Dimension Design Reference.

Click the Apply button to save your changes.

4 Click the Done button to close the Table Properties dialog box.

The structure window displays the renamed table. You are now ready
to create the fields for this table.

Let’s assume that you want to keep track of the album title, musician'’s
name, format (CD, tape, etc.), music category (jazz, rock, etc.), year
recorded, date purchased, purchase price, and notes. In the case of
classical albums, you also want to enter the name of the orchestra that
performed the piece on that album.

16  Discover 4th Dimension



Creating a Table

Fields —+—

area

» To create fields:

1 Double-click the first box in the Fields area of the [Albums] table.
The Field Properties dialog box appears, with the Attributes tab
window showing. The default name of this first field is Field1. We will
rename this first field “Album Title.”

2 Change the field name to “Album Title.”

3 Make sure that the field type is Alpha.

4 Change the field length to 45 characters.

Your Field Properties dialog box looks like this:

Field Properties

Attributes tab—— attibutes | Choizes & Help | Color|

-Field Mame———
Jadbum Title Field Type pop-up menu
- Tvpe
[alpha - [% Field Length
Eomprezsion HEtions. . |
-Att_r'
|- ™ Indexed
I~ Dizplay Only [~ Urigue
I” CantModify [~ Invisible

Done | Apply I

Later in this tutorial, we will explain the other options in the Field
Properties dialog box. For additional information about field
properties, see the 4™ Dimension Design Reference manual.

The Type pop-up menu tells 4™ Dimension what kind of data to store

in the field. Note that 4D assumes the first field to be type Alpha,
which can store letters, numbers, and special characters—often called
alphanumeric information. An Alpha field may contain between 2 and
80 characters.

5 Click the Apply button.

When you click the Apply button, 4" Dimension saves the field
definition information from Field1 and automatically adds a new field
with the default name of Field2.

Discover 4" Dimension 17



Chapter 1 Creating a Database with 4D

18

Album Title

Farmat

/
’
#
’
¢
i’
4 |Musician
¢
’
¢
¢
¢
?

Music Category

||| e

6 Create the remaining fields for the [Albums] table.

Each time you create a field, you will do the following:

= Type the field name.

= Choose the field type from the pop-up menu.

= Change the field length, if applicable.

= Click the Apply button.

Field name Zl:(lidlz)r/lz(teh Type of data you can store in the field
Musician Alpha 45 Alphanumeric Characters (maximum 45)
Format Alpha 15 Alphanumeric characters (maximum 15)
Music Category |Alpha 15 Alphanumeric characters (maximum 15)
Year Recorded |Integer Whole numbers (no decimals)

Date Purchased |Date Dates

Purchase Price | Real Numbers with decimals

Notes Text Alphanumeric characters (maximum 32,767)
Performed by | Alpha 45 Alphanumeric characters (maximum 45)

7 Click the Done button.
When you click Done, 4™ Dimension closes the Field Properties dialog

box.

8 In the structure window, position the pointer at the bottom edge of
the table image until it changes to a table resizing pointer, and drag
the bottom edge down.

The table definition for [Albums] now looks like this:

[ Abums
Album Title s
Musician e
Format e
Music Categary | /&
vear Recorded | 20
Diate Purchased | -2
Purchase Price | 02
Motes
Pertfarmed by ot

You are now ready to enter the User environment and test your table
by actually entering and modifying data.

Discover 4t" Dimension




Entering and Modifying Data

Entering and Modifying Data

We now need a way to get data into the database. In this tutorial, we
will use the default input and output forms that 4D creates.

Creating Default
Input and Output
Forms

» To enter data in a record:

1 Go to the User environment by choosing User in the Use menu.

Crl+v
Ctrl+l

The following dialog appears:

I@ Table [Albumz] dogs nat have any input or autput form.
Do you want to create default farms for this table ?

Llesign

SEr

Nofordl | vestoran | No |

2 Click the Yes button.
After 4" Dimension creates automatic forms for you, your screen looks
like this:

e 4th Dimension IS [=] B3
File Edit Use Epter Queries Heport Special Web Server Pluglns Help

o e s i e e

There are no selected records for: Albums =

\J

| -

The Design environment’s Structure window is hidden behind the User
environment window, but the Design environment is still running and
available in the background. 4" Dimension is a “multi-process”
application that allows you to have multiple environments open at the
same time.

Discover 4t Dimension 19



Chapter 1 Creating a Database with 4D

Cancel
button

Accept
button

You can have the Design environment, User environment, and several
different Custom Menu environments all open at the same time. This
feature is helpful for Rapid Application Development (RAD), because
there is no time lost in going from “development mode” to “testing

mode” to “runtime mode.”

3 Choose New Record in the Enter menu.

The input form for the [Albums] table appears; the cursor is already in

the Album Title field.

@ Entry for Albums H=]
I
% Albums voro

1 ﬂ MbumTitle |
ﬁ Musician |
E Format |
E Music Category |
——| Year Recorded | 0
ﬂ Date Purchased 0000500
ﬂ Purchase Price | 0
@ Notes ﬂ
i -

@J Performed by |
il .z
4 Enter the following data.

Field Name Data

Album Title Rhapsody in Blue, An American in Paris

Musician George Gershwin

Format CD

Music Category | Classical

Year Recorded 1988

Date Purchased 2/1/95

Purchase Price 12.95

Notes Live performance

Performed by Boston Pops Orchestra

20 Discover 4" Dimension




Entering and Modifying Data

Cancel
button

Accept
button

Your screen now looks like this:

dbryfordbams @@
Albums =
Dof0
Album Title |Rhapsody in Blue, An American in Paris
Musician |George Gershin
Format ICD—
Music Category W
Year Recorded 1988

Date Purchased |02/01/95

ST e = = B

Purchase Price | 12.95
Motes Live perfarmance. ﬂ
[
Performed by |Elost0n Fops Orchestra
=l "z

Click the Accept button.

Clicking Accept saves the record.

4D brings up a blank record for you to continue entering data. When
you save a new record that you just created in the User environment,
4D always assumes that you want to continue entering new records.
Click the Cancel button.

4D takes you back to the [Albums] Output form, where you see your
new record listed.

|=i] Albums: 1 of 1 [_ (O] =]
Alburn Title | musician =
Rhapsody in Blue, An American in Paris George Gershwin —I

Congratulations! You have created the first record in your album
collection. Now, let’s see what we can do to automate your data entry.

Discover 4t Dimension 21



Chapter 1 Creating a Database with 4D

Automating Data Entry Using Standard Choice Lists

In a database, there are usually fields that have a limited number of
possible entries. You can automate and standardize data entry by
associating standard choice lists with these types of fields. In your
[Albums] table, two fields fit that category:

Creating Standard
Choice Lists

Field

Possible Entries

Music Category

Jazz, Rock, Classical, Blues, Soul, Easy Listening, Country

Format

CD, Cassette, Video, LP Record

Let’s set up standard choice lists corresponding to the fields
[Albums]Music Category, [Albums]Format.

To create the Music Category choice list:

Go to the Design environment.

To return to the Design environment, click on any Design window or
choose Design in the Use menu.

2 Choose List Editor... in the Tools menu.
The List Editor appears.
@Lisl Editor H=]E3
List of Lists Current List
= =
. . Current List
List of Lists area
area
=
-Current [tem
= leonlD: [ 0O ™ Picture
i Li SR
%ment_ o RefiD: | 0 I=|Bold
) Min Height: | o I™ Editztl = e Add itemn
Add list | : button
button — add | e | add | [addlacrid | | oeete | [ Sar |

22

The List of Lists area lets you create choice lists. The Current List area
lets you add items to a choice list.

Discover 4t" Dimension




Automating Data Entry Using Standard Choice Lists

There are two Add buttons on this screen. The Add button in the Lists
of Lists area (the Add list button) adds a new choice list; the Add
button in the Current List area (the Add item button) adds an item to
an existing choice list.

Click the Add button in the List of Lists area.

4D creates a new choice list; the cursor is in the List of Lists text area.

4 Type the name “Music Category.”

Click the Add button in the Current List area.
4D creates a new list item; the cursor is in the Current List text area.

6 Type the new item “Jazz.”

Continue adding list items:
Rock, Classical, Blues, Soul, Easy Listening, Country.

For each new list item, click the Add button in the Current List area
and type the name of the item.

Now you can sort the current choice list. We sort choice lists to make
them an even more efficient tool for automating data entry.

To sort the Music Category list:

Click the Sort button

4D sorts the Music Category choice list items in alphabetical order. The
List Editor dialog box now looks like this:

@Lisl Editor H=] E3
List of Lists Current List
Blues -
Classical J
Country
E asy Listeir
Riock
Soul
=
- Curent [tem
| leonlD: [ 0 I Picture
- Curent List
ReflD: | 0 [~ Bold
(Eoliciis | 2 IV Editatle I featiz
add | | Deete | add | addachid | Delete | st |
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Chapter 1 Creating a Database with 4D

24

Now you can create and sort standard choice lists for the other
category: Format.

To create and sort the Format choice list:

Click the Add list button in the List of Lists area.

4D creates a new choice list; the cursor is in the List of Lists text area.

Type the name “Format.”

3 Click the Add item button in the Current List area.

4D creates a new list item; the cursor is in the Current List text area.

4 Type the new item “CD.”

wn A W N =YV

Continue adding list items:
Cassette, LP Record, Video.

For each new list item, click the Add button in the Current List area
and type the name of the item.

Click the Sort button.
4D sorts the Format choice list items in alphabetical order.

For the sake of convenience, we will now create one more choice list
that will be used in the next tutorial. This is the Nationality list.

To create and sort the Nationality choice list, just repeat the process:
Click the Add list button in the List of Lists area.

Type the list name “Nationality.”

Click the Add item button in the Current List area.

Type the new item “USA.”

Continue adding list items:

Canada, France, England, Japan, Germany.

For each new list item, click the Add button in the Current List area
and type the name of the item.

Click the Sort button.

4D sorts the Nationality choice list items in alphabetical order.
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Automating Data Entry Using Standard Choice Lists

The List Editor now looks like this:

1=d] List Editor _[O] x|
Lizt of Lists Current List
Forrnat ;I Canada ;I
Iuszic: Categor E ngland
Germany
Japan
Usa
=
- Current ltem
| leonlD: | i [ Picture
- Current List
ReflD: | i [~ Bold
Min Height: | J I¥ Ediable I ali
add | Dekte | add | Addachid | Delete | Son |

7 Click the Close Box to close the dialog box.

On the Macintosh, the close box is on the top left of the dialog box; on
Windows, the close box is on the top right.

You have created three standard choice lists. Your next step is to
associate the choice lists with fields (objects) in your database.

Associating a Choice

After you associate a choice list with a field, 4D will automatically
List with a Field

present the choice list any time you try to enter data into that field in
the Input form.

» To associate a choice list with a field:

1 Click on the Database Structure window to make it active.
You can also choose Database Structure in the Tools menu.

2 Double-click the field Format.

Discover 4th Dimension 25



Chapter 1 Creating a Database with 4D

The Field Properties dialog box appears. Note that the Attributes tab is
in the front.

: Choices & Help tab
Attribuites | Chaices & Help | Color |

—Field Mar
[Format

- Twp
[ETE N ~ | [ 15

[Eampressiam Nptiots. . |

- Attribu
[~ Mandatary [ Indexed
I~ Display Orly [~ Unigue
[~ CamtModify [ Invisible

Done I Apply I

3 Click the Choices & Help tab.
The Choices & Help window now appears in the Field Properties dialog

box.

Figld Properties
Attributes  Chaices & Help IColorl

-Field Mame
[Farmat
- Choice List
Allow Choice List
check box | =1 Choice List pop-up menu
- Tip/B alloon Help
Dore | Apply I

4 Click the Allow Choice List check box.
5 Choose Format from the Choice List pop-up menu.
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Automating Data Entry Using Standard Choice Lists

10
11

The Field Properties dialog box now looks like this:

Field Properties

Attributes Cheices & Help | Colar |
rField Mame

[Farmat

~Choi
W

| Farmat =l

rTip/Balloon Help

Done I Apply I

Click the Apply button.

4D saves your changes. Leave the Field Properties dialog box open; you
will use it again in the next step.

Click on the Music Category field in the Structure window.

Note that the Field Properties dialog box is updated; it now indicates
that you are modifying the properties of the Music Category field.

Click the Allow Choice List button.

Choose Music Category from the Choice List pop-up menu.

Click the Apply button.

Click the Done button.

You have now associated choice lists with the fields Music Category
and Format. Whenever you use those fields in data entry, searching, or

sorting, their associated choice lists will appear and let you make a
selection.

REMINDER: We will associate field with the Nationality choice list in a later
tutorial.
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Entering Data with
Choice Lists

Let’s enter a record using the choice lists to speed up and simplify data
entry. Using choice lists saves time, eliminates typing errors, and
standardizes the spelling of data entry items. This makes the
information easier to find later when you want to search for it.

To enter data using choice lists:

Go to the User environment.

Click on the User Environment window or choose User in the Use
menu.

Choose New Record in the Enter menu.
The [Albums] Input form appears.

Enter the following data:

Field Name Data

Album Title Sound of Jazz
Musician Lionel Hampton
Format Cb

Music Category |Jazz

Year Recorded 1988

Date Purchased 12/14/96

Purchase Price 12.00

Notes Traditional Jazz Vibraphone (“vibes”)

Each time you move the cursor to a field that has an associated choice
list, the list automatically appears in the middle of your screen. For
example, when you go to the Music Category field, the following
choice list appears:

Blues
Classical
Country
Easy Listening
Jazz

Fock

Soul

Madiy Cancel | Tl
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Cancel
button

Accept
button

There are two ways to select an item in the choice list:

= Type the first letter (or letters) of the name of the item you want to
enter. The item is highlighted. Click the OK button.

= Double-click the item in the list.
After you select the item, it is automatically entered into the field
Your [Albums] Input form looks like this:

Albums rurs =

Album Title  [Sound of Jazz

Musician |Li0ne| Hampton

Format |CD
Music Category |.J Az
Year Recorded I 1988

Date Purchased |12/1 4/96

Purchase Price | 12.00

Hotes Traditional Jazz Vibraphane {"vihes" ;I

|

L e e x

Performed by |

K ¥l

4 Click the Accept button.

Click the Cancel button to return to the [Albums] Output Form.

You now have two records in your database.

Alburm Titls | musician =
Rhapsody in Blue, &n American in Paris George Gershwin —I
Sound of Jazz Lionel Hampton

Congratulations! You have created standard choice lists to help you
enter and modify database records. Now, let’s see what we can do to
further expedite your data entry.
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Entering Data by Importing Records from a Document

30

Note

If you are creating all of your data for the first time, you can enter it
quickly and easily with the Input form and choice lists. However, there
is another way to get data into 4D—by importing it. This can be
especially useful if you have a great deal of data.

Suppose you have been keeping track of your album collection in a
spreadsheet. You can save your data from the spreadsheet as a text file,
and import the text file into 4D. For the purposes of this tutorial, we
have already created a text file that you can import. The name of the
file is Albums.txt.

Here is how the Albums.txt text file looks in a text editor:

= ALBUMS. TXT

Nat Fing Cole's Greatest Lowe Songs —* Nat Fing Cole -+ CD - Easy Listening
The Best of the Sylistics —+ Stylistics, The —+ Caszette —+ Soulldl/Z2/50
Johrrry Mathis, 16 Most Begquested SongsiJobrnyy Mathis —+ (0] g Easy Listening
Best of BE. B. Eing —+ E. B. Hing —- LP Pecord —* Eluss —* 11.
Carpenters - Their Greatest Hits —* Carpenters, The —+ coh —+ Easy Listening
Jazzis Magaszine April 1395 Collection—+*Warious —+ CIr i JazziDd4,/ 230705
Virtuoso - Ludwig Vean Besthowven — Eerliner FPhilharmoniker —#*CD b Classical —* 0Z,
Temptations £5th Mmiversary Volume ITTemptations, The —+ ch —+ Soalind/ 07789
Eralms Piano Quirtet - Clarinet Quintet —+ Eenda Masicians, The -+ CD
Best of Gladys Fright & the Pips, 1373-138% -+ GFladys Fright & the Pips—+* Ca:
EBad i Michasl Jackson —* Tideo -+ Souldlz/15/89
Double Good Everything —+ Smokey Robinson i CD —+ Bould0E/ 12,93
The Long Pun I Eaglesl -+ [we) - Rockil1/01/82

Depending on the text file, the albums may not appear in the same
order as shown.

The text file contains one record for each album. Within each record,
the fields are separated by tabs and the end of the record is indicated
by a carriage return. You can import files from text and several other
formats, directly into 4D.

To import data from a text file:

Close the Albums.txt file.

If you were viewing the file with a text editor, be sure to close the file
before attempting to use the file to import the information into 4D.

Choose Import Data... in the File menu.
The operating system’s standard Open File dialog appears.

Navigate to the 4th Dimension directory.
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During installation of 4™ Dimension on your hard drive, the 4D
Installer created a file called Albums.txt.

Windows Open
Loak in: gl :
1 MyMusic
Alburns. bt
Musician. txt
File name: I |&I
Files of type: [ files (7] [= Cancel |
Macintosh

3 4th Dimension ™ = Micronet 2
&j Albums.tut i

Musician. tut
[ MyMusicf

I Open I

4 Double-click the Albums.txt icon to open the file.
There is another file, Musician.txt, in the same directory. Ignore the
Musician.txt file for now; we will use it later.

The 4D Import Wizard appears, showing you the contents of the
import file. You can assign columns to fields in your database.

'mFiEhjSl = | FD”'“I File |§i Headerl = Delim\tersl &?;Formatl
Import T able: [tbums =1 File
[EMACIDiscoverdD \albums. TRT

[=28= § Albums
& /4 Album Title
/% Musician

Selected table

/% Format ~Records——— Fomat

/% Music Category

8 vear Recorded & Append Teut -
'?5 EatBhPUIC:'a‘SBd | I Replace IW’\ndows File vl

I Create Table

(=N @l ;'is.j Cancsl | Import |

Fleld aSSOCiated — % AbumTile ™ | /% Musician T |/ Fomat | /& MusicCat.. * | 2%ear Reco..™ |-Z] Date Purc... ﬂ
to each column Nat King CvMat King G CD Easy Liste: 0 03/12-92
The Best o Stvlistics Cassette Soul 0 01-22.-90
C fth Johnny Mat! Johnny Mat! CD Easy Liste: D 03-03-90
Contents of the — 5.t of B. B. B. King LD Record Blues 0 11/11/95
lmport file Carpenters  Carpenters CD Easy Liste: O 040692 =]
1 | o
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32

The Import Wizard assumes that the data in your import file is in the
same order as the fields in your database. However, if some of the field
choices are not correct, you can easily go to each pop-up list and

change the field selection.

Check that all columns of the import file are imported into the
corresponding field. If necessary, manually change the field selection
by choosing the correct field from the pop-up menu at the top of the

column:
@ Import [ x|
1z Fields | = Fnrml File: |§i Headerl = De\imitelsl R Formatl
Import T able: |A|bums ;I Fil
[CAACIMDiscoverdDhAlbums TXT
H
& /% Album Title Browse...
/% Musician
/% Format ~Records———— Fomat
/% Music Category ’V
b Ve Recoded & Append Text T
5] Date Purchased Mot imported
5o LI i Replace
Album Title: =
[~ Create Table (¥R
Farmat —
glﬁl ;.fj _ MusicCategary :I
“rear Recorded
Format ¥ | A MusicCat.. ¥ | 2%¥ear Reco.. ™ |EDate Purc... © _ Date Purchased i ﬂ
)] Easy Liste: 0 03-12-92 12.5 |
issette Soul i] 01-22-90 §.79 Motez |
)] Easy Liste: 0 030390 9 Performed by~ | |
? Record Blues i] 11711796 13.75 :
)] Easy Liste: 0 04-06-92 11.5 -|
B L

For more information about the 4D Import Wizard options, see the
Dimension User Reference Manual.

4 th

Click the Import button.

4D returns to the [Albums] Output form, which displays the 19 records
that you just imported. Note that the top of the window now says
“Albums: 19 of 21,” which means that you now have 21 records in

your database.
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@Alhums: 19 of 21 [_[O]

Alburn Title | Musician =
Season for Love London Symphony Orchestra —I
Johnny Mathis: In The Still Of The Hight Johnny Mathis

Lucille and Other Classics by Kenny Rogers Kenny Rogers

Johnmy Mathis, 16 Most Requested Songs Johnny Mathis

Hat King Cole's Greatest Love Songs Nat King Cole

Virtuoso - Ludwig vVan Beethowven

Kool & The Gang Spin Their Top Hits
Jazzis Magazine April 1995 Collection
The Long Run

Whitney Houston

Double Good Everything

Best of B. B. King

Brahms Piano Quintet - Clarinet Quintet
The Best of the Sylistics

Bad

rT

Berliner Philharmoniker
Kool & The Gang
Various

Eagles

Whithey Houston
Smokey Robinson

B. B. King

Benda Musicians, The
Stylistics, The

Michael Jackson

—— Llﬂ

Choose Show All in the Queries menu.

The [Albums] Output form lists all 21 records in the [Albums] table.

\=d] Albums: 21 of 21 _ O]

Album Title

|ru1usician =

Rhapsody in Blue, An American in Paris
Season for Love

Johnmy Mathis: In The Still Of The Hight
Lucille and Other Classics by Kenmy Rogers
Johnmny Mathis, 16 Most Requested Songs
Sound of Jazz

Hat King Cole's Greatest Love Songs
Virtuoso - Ludwig WYan Beethoven

Kool & The Gang Spin Their Top Hits
Jazzis Magazine April 1995 Collection
The Long Run

Whitney Houston

Double Good Everything

Best of B. B. King

Brahms Piano Quintet - Clarinet Quintet

T

o

George Gershwin
London Symphony Orchestra
Johnny Mathis

Kenny Rogers

Johnny Mathis

Lionel Hampton

Hat King Cole

Berliner Philharmoniker
Kool & The Gang
Various

Eagles

Whitney Houston
Smokey Robinson

B. B. King

Benda Musicians, The

PO — Llﬂ

Congratulations! You have imported records from a text file into your

database.
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Finding Records in Your Database

Sorting Records in a

Table

Queries
Show Al Cir+G
Shimw Subiset [t
Guen... Ctil+5
Guery by Example... Ctri+L
Query and Modify. .
CQuery by Formula..

As you add more records to the database, you will notice that finding
records becomes more difficult. Suppose, for example, that you have
150 Album records in your database. If your monitor can display 15
records per screen when displaying the Output form, you might have
to scroll through as many as 10 screens to find a specific album.

To make it faster and easier to find information in a large table,

4™ Dimension allows you to arrange the records in alphabetical,
numerical, or date order. When you arrange the records in this way,
you are putting the records into Sorted Order.

To sort records:

Choose Order by... in the Queries menu.

The Order By Editor appears.

@ — Order by E ditor
i i Ordered by Fields/Formulaz
-
/% Format
/4 Music Category
25 Vear Recorded
B Date Purchazed
02 Purchaze Frice —'I
Mates _I«
/% Performed by LI
=
= AddFormula.. | Medfy. |
Cancel I [rclern by I

Double-click the field Musician in the Available Fields list.
The field appears in the Sorted Fields/Formulas list.
Double-click the field Year Recorded.

The field appears in the Sorted Fields/Formulas list.

In the Ordered by Fields/Formulas list, click once on the Sort Direction
arrow for the Year Recorded field.
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The arrow changes to point downward. You have instructed 4D to sort
your albums alphabetically by Musician, with the musician’s most
recent albums first in the list. The Order by... Editor looks like this:

—Order by Editar

=

Available Fields

74 Album Title

/% Musician

/% Format

4 Mugic Category
B car Recorded

%] Date Purchased

| Ordered by Fields/Farmulas

(12 Purchase Price 1
Motes LI
/% Perfarmed by LI
=
= Add Formula... | Modiy.. |
Cancel | Order by I

5 Click the Order by button.

Sort
direction
arrows

The records are sorted alphabetically by musician, with the musician’s

most recent albums first.

|=i] Albums: 21 of 21 =] =
Alburn Title Musician jl

Best of B. B. King

B. B. King

Brahms Piano Quintet - Clarinet Quintet

Benda Musicians, The

Wirtuoso - Ludwig van Beethowven

Berliner Philharmoniker

Carpenters - Their Greatest Hits

Carpenters, The

The Long Run Eagles
Rhapsody in Blue, An American in Paris George Gershwin
Best of Gladys Knight & the Pips, 1973-1088 Gladys Knight & the Pips
Johnmy Mathis: In The Still Of The Night Johnny Mathis
Johi 16 Most Requested Songs Johniy Mathis
Lucille and Other Classics by Kenny Rogers Kenny Rogers

Kool & The Gang Spin Their Top Hits

Kool & The Gang

Sound of Jazz

Lionel Hampton

Season for Love London Symphony Orchestra
Bad Michael Jackson
Hat King Cole's Greatest Love Songs Mat King Cole

K1

i

Although you cannot see the Year Recorded field on this screen, 4D
also used that field in the sort. For more information about the options
in the Order By... Editor, see the 4" Dimension User Reference Manual.
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Querying by

Example

Queries

Shaw Al Chl+G
Show Subset ISt E
Huen... Chrl+5

Query by Example...

Querny and Madify...
Querny by Formula. .

Crl+L

DOrder by...

Chrl+T

36

Sorting the records and then scrolling to find a particular album works
very well for a few dozen records, but it does not work well for larger
numbers of records. As your music collection grows and the number of
records increases into the hundreds, you will need a better way to find
a particular record. 4D allows you to search for a particular record by
bringing up a Query screen that resembles your data entry screen. You
type in an example of the information that you're looking for, and 4D
looks for matching records. That feature is called Query by Example.

To find records by example:

Choose Query by Example... in the Queries menu.

The Query by Example wizard appears.

- =]
.  Alb

ums tof1

Album Title |

Musician |
Format | & Cursor
Music Category I—
Year Recorded I—

Date Purchased I—
Purchase Price I—

Notes

cle e X

Performed by |

¥

A 7

“IEE

You will find this wizard very easy to use, because it looks exactly like
your input form. You will notice, however, that the cursor is an eye
instead of the standard arrow pointer.
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Accept
button

2 Click on the Music Cateqgory field.
The Music Category choice list appears.

Blues
Classical
Counkry
Eazy Ligtening

=

Modfy |  Cancel | ok |

This demonstrates the advantage of associating a choice list with a
field in the structure—any time you enter data into that field or search
by that field, the choice list will appear automatically.

Your screen looks like this:

I=i] Entry for Albums [_[O]

3 Double-click the list item Classical.

Albums

=

1of1

Album Title |

Musician |
Format I—
Music Category W
ear Recorded I—

Date Purchased I—
Purchase Price I—

Hotes

Performed by |
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4 Click the Accept button.

Indexing to Improve
Search Performance

4D finds the Classical albums in your collection.

Alburn Titls | Musician =
Rhapsody in Blue, An American in Paris George Gershwin —I
Season for Love London Symphony Orchestra

Virtuoso - Ludwig Van Beethoven Berliner Philharmoniker

Brahms Piano Quintet - Clarinet Quintet Benda Musicians, The

As the number of records in your database grows, these queries will
become slower and slower, because the database has to look through
the records sequentially (one-by-one), compare every record to your
search example, and then display the records that you are looking for.
Instead of doing a sequential search, 4D can make use of something
called an Index. An index in a database works very much like an
indexed Card Catalog in a library—Card catalogues are indexed by
Author, by Title, and by Subject. If you want to find all the books about
Classical music, you look in the Subject card file that contains the
“C’s” and then under the “C’s” you scan alphabetically until you find
“Classical.”

Databases use the electronic equivalent of card catalogues. In
databases, instead of calling them card catalogues, we call them
Indexes. Classical will appear in the Music Category Index, and CD
will appear in the Format index. When you search by example for CD’s
of Classical music, the database will quickly find all the records that
meet both conditions: “Classical” Music and “CD” Format.

To set up some indexes in the [Albums] table.

Go to the Database Structure window in the Design environment.

Choose Design under Use menu, or click directly on the Structure
window if it is already visible.
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2 Double-click the Album Title field.
The Field Properties dialog box appears.

Field Properties

Attributes |Ch0ices & Help| Color|
rFigld Mame

Album Title

- Typ
[#1gha =[5
[EampressiomUptons.. |

Attributes

[ Mandatary I Indexed
[~ Display Only [~ Urigue
[~ CantMadify [~ Inwisible

Dore | Apply I

3 In the Attributes tab, click the Indexed check box.

4 Click the Apply button.

The dialog box now looks like this:

Field Properties

Attributes I Choices & Help | Color |

-Figld Mame

Album Title

mTyp
IAIpha vl I 45
[Eompressiam ptions... |

Attributes
I Mandatary ¥ Indexed
[~ Display Orly [~ Unique

[~ Camthodify [ lewvisible

Done I Apply I

5 Leave the Field Properties dialog box open, and repeat the same
procedure with three additional fields:
Musician, Format, Music Category

Each time, you will:

Click on the field.

Click the Indexed attribute check box.
Click the Apply button.
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Summary

Your Structure window now looks like this:

Albums

Album Title

Musician

Format

Music Category

‘fear Recorded

Date Purchased

Purchase Price

Motes

|| D sl ||| e

FPerformed by

4D shows the names of the indexed fields in bold type. When you
query these fields, the performance will be 10 to 100 times faster than
it was before you indexed the fields.

Click the Done button to close the Field Properties dialog box.

Congratulations! In this chapter, you have learned how to:
Create a table, create fields, and change the properties of fields.
Create standard choice lists.

Create default input and output (listing) forms.

Enter new records and modify existing records.

Import records from a document on disk.

Find records in your database.

Index fields to improve search performance.

If you want to take a break before going to the next chapter, be sure to
Quit (Exit) 4D before turning off your computer.
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2 Adding Tables and
Creating Relations

Estimated time to complete: 30 minutes

In this chapter, you will learn how to design a relational database using
4™ Dimension. You will also learn some database terminology, such as
relational database and one-to-many. When you have finished this
chapter, you will know how to do the following:

Create a [Musicians] table to store information about musicians.

= Define a relationship between the tables [Albums] and [Musicians].

Use several advanced options of the Form Wizard.

View and edit data from both tables on the same form.
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Understanding Relational Databases

42

As you have seen, a single-table database has some definite
advantages— it is quick, simple, and easy to understand. Depending
on how detailed you want to be in keeping track of your data, a single
table may be sufficient. However, if you need more power, you can use
4™ Dimension as a relational database.

The Relational Database of your two tables looks like this.

Musicians

Musician Name Year of Birth Nationality

Albums

Album Title Musician Name

Simply stated, a relational database is a collection of tables with the
following characteristics:

= Specialization: Each table “specializes” in storing a certain type of
information. In the example shown, the [Albums] table stores
information about albums, and the [Musicians] table stores
information about musicians.

= Key fields: Each table has a column called the “Key Field.” The data in
this key field is unique—no two records will have exactly the same data
in the key field. This unique quality is what makes it possible to
distinguish one record in the table from all other records in the table.
In the example shown, the key field for the [Albums] table is
[Albums]Album Title. The key field for the [Musicians] table is
[Musicians]Musician Name.

= Indexed: Each key field is indexed for fast searches.

= Relations: Some of the tables are related to each other, so that they can
share information. That is the reason for the term relational database.

Discover 4t" Dimension



Advantages of a Relational Database

Note

Duplicated related fields: To identify the relationships, we copy the
key field data into the related records. For example, when we enter
records related to the musician Johnny Mathis into [Albums], we copy
Johnny Mathis’ name into the [Albums] table record. This makes it
possible for us to match or relate [Albums] information to [Musicians]
information.

For several technical reasons, many professional database designers
prefer to use a sequence number as the unique field, instead of using
real-world data such as a name. For example, you can assign each
album a unique ID number, and use that number as the unique key
instead of the title of the album. You can set this up and let 4D keep
track of the unique number sequences for you. In the 4™ Dimension
folder, there is an expanded example, “MusicPro,” in which we show
you how to use automatic sequence numbers. For detailed information
on setting up unique ID numbers, see the 4™ Dimension Design
Reference Manual.

Advantages of a Relational Database

Data Lookups

Flexibility

Now that you understand the basic idea of a relational database, let’s
briefly discuss the advantages of having a relational database.

Instead of re-typing the same data over and over, you can use a relation
to look up the data and display where you need it. In the MyMusic
database, we can type in the musician information one time in a table
called [Musicians]. After that, instead of retyping the musician’s name
for each record in the [Albums] table, we can let 4D automatically copy
this information into the record for us. Not only does this save time,
but it also eliminates typing mistakes, making our data entry more
consistent and more accurate.

You gain flexibility with a relational database, because you don’t need
to know in advance how many albums you will have by a musician, or
how many songs there will be on an album. If you have one album or
one hundred albums by the same musician, your system can handle it.
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Analysis and
Reporting

Scalability

Analysis and reporting capabilities with a relational database are far
more powerful than with a single-table database. You can look at the
information in many different ways. For example, suppose you are
planning a party and you want to schedule your music. You can ask
your relational database the following questions:

How many Easy Listening CD’s do I have?

[ want to play Beethoven’s music during dinner. Which Classical CD’s
have selections that were written by Beethoven?

After dinner, I want to play dance music—Rock and Soul. Give me a list
of my Rock and Soul albums.

This is just a small sample of the types of answers you could get from a
relational database.

Scalability is the ability of a database to grow with your needs.
Although we have used a two-table database in our example, real-life
relational databases can be much larger in scale.

You can continue to add tables to your database as your information
storage needs grow and change. The current version of 4™ Dimension
allows you to create 256 tables.

When you finish this tutorial, you will have a very handy tool for
storing information about your personal albums; however, if you want
to take it farther, you can. In addition to the [Musicians] and [Albums]
tables that we cover in this tutorial, the expanded MusicPro example
in the Example Databases folder contains the following table:

The [Album_Songs] table stores information about the songs on an
album. You can use this table to find all the different renditions of the
same song: the album, the track, the tempo, and the length (in
minutes) of that version of the song.

Thus, scalability—the ability to expand your database as your needs
expand—is one of the primary advantages of the relational model.
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Creating a Second Table

Creating a Second Table

To store information about the performers on your albums, you will
create a table called [Musicians].

Creating the Table

» To create a table:
1 Choose New Table... in the Structure menu.
4D prompts you to name your new table.

]
’@ Please enter the new table name.

Cancel | Ok I

2 Enter “Musicians” and click OK.
4D creates the new table. The Table Properties dialog box appears.

Table Properties H

Privileges |Triggets| Eolorl

T able M ame
|M ugicians

Recod Access ———————————————————

Load:

Save: IAII Groups - l
Add: IAII Groups - l
Delete: IAII Groups - l

~Table Dwner————————————————
|AII Groups LI

Done | Apply I

For information about the options in the Table Properties dialog box,
see the 4" Dimension Design Reference.

3 Click the Done button to close the Table Properties dialog box.You are
now ready to create the fields for this table.

Discover 4th Dimension 45



Chapter 2 Adding Tables and Creating Relations

Creating Fields

» To create new fields:

1 Double-click in the first box in the Fields area of the [Musicians] table
to create a new field.

The Field Properties dialog box appears, with the Attributes tab
window showing. The default name of this first field is “Field1.” We
will rename this first field “Musician Name.”

2 Change the field name to “Musician Name.”
3 Make the field type Alpha, the length 45.

4 Click the following field attribute check boxes:
Mandatory, Indexed, and Unique to turn them all On.

The settings for the Musician Name field look like this:

Field Properties
Attributes tab [~ Aftibutes | Choices & Help | Calor |

-Figld Name———
Musician Name Field Type pop-up menu

- Tep
[2pha =l [ Field Length
[Eompressiam Wt |

- Aftributes

¥ Mandataory v Indexed
[~ Display Orly [V Unique
[~ CantModify [~ Invisible

Done | Apply I

5 Click the Apply button.

6 Create the remaining fields for the [Musicians] table.

Field name Field type Attributes Remarks
and length
Year of Birth Integer
Country of Birth | Alpha 20 Indexed: Use the “Nationality” choice list
Choice List
Year Deceased |Integer
Notes Text Up to 32,000 characters

46 Discover 4th Dimension



Creating a Second Table

Each time you create a field, do the following:

= Type the field name.

= Choose the field type from the pop-up menu.
= Change the field length, if applicable.

= Click the Apply button.

7 Associate the Nationality choice list with the Country of Birth field.
Remember the Nationality choice list that we created in the last
tutorial. We will now associate it with the Country of Birth field in the
[Musicians] table.

To refresh your memory, here are the steps for associating the choice

list with a field:

= Double-click the field name [Musicians]Country of Birth in the
structure window. This brings up the Field Properties dialog box.

= Click the Choices & Help tab to display the Choices & Help tab
window.

= Click the Allow Choice List check box to turn it On.
= Choose Nationality in the Choice List pop-up menu.

= Click the Apply button.

The Field Properties dialog looks like this:

Field Properties

Attributes  Choices & Help | Colar |

rField Name:
|Country of Birth

rChoice List
¥ &llow Chaice List

[Natioraiy ]3|

r Tip/Balloon Help

Done | Apply I

8 Click the Done button.

When you click the Done button, 4" Dimension closes the Field
Properties dialog box.
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In the structure window, the table definition for [Musicians] now looks
like this:

[ Musicians

[Musician Name | / Names of indexed fields
Year of Birth A are in bold type
Country of Birth | /

Year Deceased | 2°
Motes

Establishing the Relationship Between Two Tables

48

Now that you have the [Albums] and [Musicians] tables, you are ready
to establish the relationship between them. Fach musician could
record several albums, so you have a “one-to-many” relationship
between [Musicians] and [Albums].

To define this relationship:
In the table [Albums], click the field name [Albums]Musician.

Drag a line from the field [Albums]Musicians to the field
[Musicians]Musician Name.

Important: When defining relations, always drag the relationship line
from the Many table to the One table.

Eﬁlluclme for MyMuszic 4DB o]
=
[ Abums _
Album Title A
Musici A [ Musicians
usician e
‘Yedr of Birth o
Music Category | /% >
Country of Birth
‘ear Recorded | 2 v b
Date Purchased [ .21 ‘ear Deceased 6
Notes
Purchase Price | 02
Notes
Perfarmed by A
-
KN e
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When you release the mouse, the Relation Properties dialog box

Definition | Control | Colar |
rRelated Fields

From: [[AlburnsM usician

To: |[M ugicians|Muszician Mame

rany to One Options

™ Ao wildcard support

¥ Prompt if related one does
niot exist

rOne to Many Options

I™ Ao One bo b any

v Auto azzign related value in
subfarm

Done | Apply I

3 Make sure that all of the check boxes are selected to be On.
Click to select: Auto Wildcard support, and Auto One to Many.
All check boxes should be selected. So far, the Relation Properties
dialog box looks like this:

Relation Properties

Definition | Contral | Colar |
rRelated Fields

From: [[AlburnsM usician

To: I[M ugicians]Muszician Mame

rtany to One Options

W Auto \wildcard suppart

¥ Prannpt if related one doss
ot exist

rOne to Many Options

W futo One o b any

v Auto azzign related value in
subfarm

Done | Apply I

4 Click the Control tab to set your Lookup Control options.
5 Highlight the field Country of Birth as your Wildcard Choice.
6 Click the Apply button to save the changes.
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50

The dialog box now looks like this:

Relation Properties
Definition Cantrol | Calar |

rRelated Fields

rwildcard Choice

Muzician Mame d
“r'ear fo Birth
Country of Birth
‘Year Deceased
Motes
[
rDeletion Cantral
| eayveelated many intact
) elete related many
) Garimot delete i related many
[ione | Apply I

For information about the other options in the Relation Properties
dialog box, see the 4" Dimension Design Reference Manual.

7 Click the Done button to close the window.

Your structure window now looks like this:

Country of Birth | A

Year Deceased | 2°

Year Recorded

E
[ oums 7
Musician A @
Format A —I—> Musician Hame | A«
Music Category | /A Year of Birth Bl
=0
|

Date Purchased

Motes El
Purchase Price | 09 &
Notes
Perforrned by A
=
a 37

Congratulations! You have just created your first One-to-Many relation
in 4" Dimension!
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Adding Data to the New Table

Before you use the new relation, you need to add some data to your
new [Musicians] table. First you will create a new record to test the
Input form, then you will import some additional records, as you did
for the [Albums] table.

» To create the first record:

1 Go to the User environment by clicking on any User environment
window, or by choosing User in the Use menu.

v

Dezign  Chl+y
User  Ctrl+l The following dialog appears:

Create Default Forms

’@ Table [Musicians] does nat hawve any input or output formn.
Do you want to create default forms for this table #

Nofordl | esforal Mo |

2 Click the Yes button.

When you go to the User environment,
the Output form of the [Albums] table.

4™ Dimension returns you to

Album Title | Musician =
Rhapsody in Blue, An American in Paris George Gershwin —I
Season for Love London Symphony Orchestra

Virtuoso - Ludwig Van Beethoven Berliner Philharmoniker

Brahms Piano Quintet - Clarinet Quintet Benda Musicians, The

3 Display the List of tables dialog box (if necessary).

B niburns =l In the User environment, you can use the List of tables dialog box to
EE “jump” to any table in your database. Here are the shortcut keys to
present the List of tables dialog box:

Platform To present the List of tables dialog box
Windows Hold down the Ctrl key and press the Space bar
’ﬂ Macintosh | Hold down the Command key and press the Space Bar
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4 Click the word Musicians to go to the[Musicians] table.
You jump to the [Musicians] table.

| Fal| List of tables =]
B B aibums -
= = | records for: Musicians

@ husic

£ o

The screen informs you that no records are selected for the [Musicians]
table.

5 Choose New Record in the Enter menu.

MewRecod  CtileM The Input form for the [Musicians] table appears; the cursor is already
fodily Fizcord  Calibd in the Musician Name field.
Al Earmmla 4th

Dimension created this form for you automatically!

|z Entry for Musicians mEE
=
Musicians
0of 0

Musician Name |

Year of Birth | 0

Country of Birth |

Year Deceased | 0

Notes ;I

Erter it [Lrsk [StrlE,

S = S A

il w4

Note 1f the List of tables dialog box is still in the front of your screen, just
click on the Input form to bring it forward.
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Cancel
button

Accept
button

6 Enter the following data:

Field Name Data
Musician Name | Johnny Mathis
Year of Birth 1935

Country of Birth |USA
Date Deceased

Notes Born in Texas, raised in San Francisco.
Started music career in 1956.

Your screen now looks like this:
@Enlw for Musicians [_ O[]
Musicians Al

Dof0

Musician Name |.J0h nny Mathis

Year of Birth I 1935

Country of Birth [USA

@ Year Deceased | 1
— Hotes Barn in Texas, raised in San Francisco. ;I
ﬂ Started music career in 1956.
ki oz

7 Click the Accept button to save the record.

4™ Dimension saves the record and brings up a blank record for you to

continue entering data. When you save a new record that you just
created in the User environment, 4D always assumes that you want to
continue entering new records.

8 Click the Cancel button.

4™ Dimension takes you back to the [Musicians] Output form, where
you see your new record listed.

@Musicians: 10of1 M=l =
Musician Name I‘r‘earofElirTh |Countr\,r of Birth |‘r‘ear r=|
Johnny Mathis 1935 USA [
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Importing Records into the Table

Windows

Macintosh

In Chapter 1, you imported data into the [Albums] table. Now, you will
import data into the [Musicians] table. We have already created a text
file that you can import. The name of the file is Musician.txt.

The text file contains one record for each musician. Within each
record, the fields are separated by tabs. The end of the record is
indicated by a carriage return.

To import the text file into 4™ Dimension:

Choose Import Data... in the File menu.

The operating system'’s standard Open File dialog appears.

Open

Look in:

1 Mybusic
Albums. bt
Musician. st

File narne: | Open |
Files of type: [l files (-] =l Cancel |

3 4th Dimension ¥ —Micronet 2
Albums.txt B m

Ej Musician.txt
DMgMusicf Desktop

- I Open I

If you are not already in the directory where the file Musician.txt is
located, you will have to navigate to that directory.
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Selected table

F|e|d aSSOCiated — % Musician... ™ ZSYEa[DfBilth' Atountr_uof o ZsYearDece...' ﬂ

to each column

Contents of the
import file

—Btylisties 0 Usa 0

2 Double-click the file Musician.txt to open it.

The 4D Import Wizard appears, showing you the contents of the
import file. If necessary, you can align the columns in the Musician.txt
import file with the fields in your database.

1=4] Import

11z Fields | = Forml Fil: |§i Headerl = Delim\lersl &# Furmall

=
File

|C WACINDisooverdD \Musician, TAT

Impoit T ablz: |Musicians =l

/% Musician Mame
% ear of Bith
/4 Country of Birth rRecods—— [Fomat

i A0 Year Deceased
LB Motes & Append Text =

| O Replace IW’\ndows File =]

I~ Create Table

% @l .E.fj Cancel | Import |

Boston Pop: 0 UsA 0
Lionel Ham:0 Usa 0
HNat King 1918 UsA 1985 Born and 1

B. B. EKing: 1925 UsA a Born 1825 -
=l »

The Import Wizard assumes that the data in your import file is in the
same order as the fields in your database. However, if some of the field
choices are not correct, you can select a different field to import a
column into by choosing a field from the pop-up menu at the top of
that column.

For additional information, and for help with specific importing
challenges, see the 4™ Dimension User Reference Manual.

Click the Import button.

4D returns to the [Musicians] Output form, which displays the

20 records that you just imported. Note that the top of the window
now says “Musicians: 20 of 21,” which means that you now have a
total of 21 records in your database.
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usician Narme |Year0fElir1h |Countr\,r of Birth |Year i<
Boston Pops Orchestra o uUsa —I
Lionel Hampton o uUsa

Nat King Cole 1918 USA

Stylistics o uUsa

B. B. King 1925 USA

Carpenters o usa

Warious o

Berliner Philharmoniker 0 Germany

Temptations o usa

Benda Musicians 0 Usa

Gladys Knight & the Pips o uUsa

Michael Jackson 1958 USA

Smokey Robinson o uUsa

Eagles 1972 USA

Donald-D 0 USA

Anita Baker 0 Usa

Fnhby Brown n sa f
Al 3

4 Choose Show All in the Queries menu.

| Chl+G

The [Musicians] Output form displays all of the records in the

How Sutser [SirlEH
py St [Musicians] table.
Query by Example... Chri+L
Query by Formula... Musician Name |xtear of Birth | Country of Birth [vear Ll
Drder by... Chl+T Johnny Mathis 1935 USA o
Boston Pops Orchestra 0o uUsa
Lionel Hampton o uUsa
Nat King Cole 1918 USA
Stylistics 0 UsA
B. B. King 1925 USA
Carpenters o usa
Yarious 1]
Berliner Philharmoniker 0 Germany
Temptations o usa
Benda Musicians 0 Usa
Gladys Knight & the Pips o uUsa
Michael JacKkson 1958 USA
Smokey Robinson 0o uUsa
Eagles 1972 USA
Donald-D 0 usa =
Al 5
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Creating a Relational Data Entry Form

Your next step is to create a data entry form that enables you to enter
and view data from both tables at the same time. Using the Form
Wizard, you will first create a subform in the [Albums] table; then you
will add the subform to your [Musicians] Input form. The relational
Input form will look like this:

Main Input Form - [Musicians] table

Subform - [Albums] table

Creating a Subform

in a Table

Buntime Explarer
Find..

Databaze Stucture
Ienu Bar Editor
List Editor
Passwords

Picture Library

» To create a subform in the [Albums] table:

1 Go to the Design environment by clicking on any Design environment
window, or by choosing Design in the Use menu.

2 Choose Explorer in the Tools menu to present the Explorer window.

& Tables = Formsl =l Methodsl K Constanlsl =] Commandsl im Listsl
B 5  Albums @ Preview C Commerts
- B Musicians ’W
Album Title -
Musician s
Format -
Music Category | /A
Year Recorded | 2%
Diate Purchased | -2
| Purchase Price | 03
I [putFarm = | Gt o ¢E| MNotes
Parfarmed b st
wew | [CEE || Do | Y

3 Click the Forms tab to bring it to the front.

[Albums] should already be selected. If it is not, select it. Note the
thumbnail image of the [Albums] table on the right.
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4

O ® N &

Note

Click the New button
The Form Wizard appears.

@ Mews Form for Table:
|Albums LI

Fom Name
Form Type: |Detail Farm ;I
Template used: IClaSSiC LI [elete |
Auvailable Fields Selected Fields
| Master Table =l =
m

) Date Purchased

/% Format [ |

/% Music Category W |

/4 Musician (=] |

Motes 1

/4 Performed by v I

? Purchase Price

& - i
Advanced... | Cancel | Edit I Use | vig—=

Every form in 4™ Dimension is associated with a table. This form will

be associated with your One table, the [Musicians] table.

Choose Albums in the New Form for Table: pop-up menu. It may
already be selected.

In the Form Name: text box, change the form name to “Subform.”
Choose List Form in the Form Type pop-up menu.
Choose Simple (subform) in the Template used pop-up menu.

In the Available Fields list, double-click to select each of the following
fields: Album Title, Format, Music Category.

You may have noticed that there is an Advanced... button on the Form
Wizard. This button gives you access to several advanced form design

features in 4" Dimension. To learn more about the Form Wizard, see

the 4" Dimension Design Reference Manual.
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So far, your screen looks like this:
Newbom

@ Mewvs Form for Table:

|abums =l

Form Mame: |Subf0rm
Forrn Type: | List Form B3

Template used: ISimpIe [subfiorm) LI [elete |
Available Fields Selected Fields

[Master Table 3 Album Title El
/4 Album Title i’ Format

4 Date Purchased

/% Format

k2] Music Category

/% Musician
Motes
/% Perfarmed by

? Purchase Price
¥ - |

Advanced... | Cancel | Edit I Usze | rig—

Z 22 €

10 Click the Edit button.

4th

4 4e Dimension 1= [=1 3
Fie Edt Lse Design ok Fom Obiest Font Stle Aids

e e e e ) A T B]a <]
[0 (& Form: [AlbumsiSublorn Gl | W Ivear Deceased Ihotes =
[ =1 0/ Bornin Tex:
Tl 0
0 111 0
(n 1965 Born and ra
i 0
oo (n 0/Born 1925 it
i 0/ Karen & Ric
50 0
........ e T e e T ‘mally 0
Ter — U a0 100 150 oo 1] > 0
Bemga%vlﬁluuua % f 0
Gladys Knight & the Pips 0 USA 0
Michael Jackson 1958 USA 0 Bornin Gany,
Smokey Robinson 0 usa 1]
Eagles 1972 USA 0 Band forme
Donald-D 0 'Usa 0
Anita Baker 0 USA 0 =
& L7

Dimension opens your new subform in the Design environment.

4D only shows you a small portion of the subform. To see the rest of

your fields, you can use the scroll bar or expand the window.
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Adding the Subform The next step is to drag the subform onto the Musicians Input form in

to the Main Input

Form operation will look like this:
Subform from [Albums]
Main Input Form - [Musicians] table »
» To drag the subform onto the [Musicians] Input form:
1 Choose Explorer in the Tools menu.
The 4™ Dimension Explorer appears, with the Forms tab showing.
Windows | Explores [-[OI=]
H Tables = Formsl = Methudsl K Cunslanlsl = Cummandsl im Lislsl
Expand/— -] ) Preview O Comments
Collapse Musgicians
button
Musician Mame | /2
‘tear of Birth 26
Country of Birth | /&
‘vear Deceased | 2°
Notes
I [t B I | Wt o =a
New | [ Eat | | el |
Macintosh [F—————————=—=mer————=0518
[ B Tables | I Forms I 2] Methods " K Constants " [ Cormmands " 134 Listsl
Expand/ = E Albums =] @) Preview () Comments
CO”apSe E Input | ’W
button H output o —
o Musician Name | /%
<+ [ Musicians
H gt . Vear of Birth ol
& output 0 Country of Birth | A
Year Deceased 28
Notes
| O =
e J1 J I |
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Creating a Relational Data Entry Form

Note 1If the list of forms for each table is not expanded to display all the

Note

forms for each table, click the Expand/Collapse button to show them.

Click the [Musicians] Input form icon.

Note the preview of the [Musicians] Input form on the right side of the
Explorer window.

8C| Explorer H=] B3
5 Tables & Formsl = Methodsl E Constantsl = Commandsl 1 Listsl
:I & Preview O Comments

Musicians

Musician NamelMusician RE
Year of Birth |Year of E
CuumryufBirtthuumry of B

Year Deceased |vear Dec

Notes | Motes

The Preview/Comments radio buttons above the form preview allow
you to display either the preview or the comments for the selected
object. Using comments is particularly appropriate for databases being
developed by multiple programmers as well as, more generally, for the
maintenance of your database code. For more information, refer to the
4™ Dimension Design Reference Manual.

-

I~ Input Form r Output Form =E|

New | [ Eat | | e |

sRiEE R X

Double-click the [Musicians] Input form icon to open the form
The [Musicians] Input form appears on your screen.

Expand the size of the Input form window so you can see the bottom
of the form.
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Choose Explorer..., again, in the Tools menu.
Click the [Albums] Subform icon.

Arrange your screen so that the [Musicians] Input form is visible on
the left, and the Explorer is visible on the right.

Click and drag the [Albums] Subform icon to the bottom of the
[Musicians] Input form.

é #th Dimension
File Edit Use Design Tools Aide

S[5|R] 2 |55[ |2 ||| = || =] 5oz |m] [

Musicians. - -

3]

: JEKD'DIEI H[=] E3
* MusicEan Name [ cian Name [ Tables i Foms | 24 Methods| K. Corstonts| [ Commands| bm Uists|

- Year of Birth- |‘r’earnfE =0

5| & Preview C Comments

- E- H Albums
[ CountryufBlnhICoumw of Birth H Input | ” Album Title

EVear Beceased YearDe( : : : E Output o Album Title

B- B Musicians
H Input |
- E Oulput il

™ Input Form I~ Ouput Fom — =p)

New | [ Edt |  Dekete |

| @@@@@@@@m g
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Designating the
Full-Page Form

You will see the subform in the Input form where you released the
mouse button. In 4D terminology, the subform is now an “Included
area” on the [Musicians] Input form.

9 Move the Subform to align it on the [Musicians] Input form.

Your screen should look like this:

¢ Form: [Musicians]input M=

D b

* * Year Deceased [Year Dec

.. Hotes . . . . . [Motes

- [ atoum Titie Music Category

- |[Ribum Title [[[Format Music Category]

Now that you have the [Albums] subform as an included area in the
[Musicians] Input form, you will want to use it to enter information
about several albums by a given musician.

In 4D, you can double-click an included area to present a full-page
form associated with it. This is useful for data entry in a subform.

You will designate the [Albums] Input form as the full-page form that
will appear when you double-click the included [Albums] subform.

To assign the full-page form of an included area:

Choose Explorer... in the Tools menu.

While pressing the Shift key, click and drag the [Albums] Input form
icon into the included area on the [Musicians] Input form.

This assigns the [Albums] Input form to be used by the [Albums]
subform.
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Testing the New Let’s go back to the User environment and see how the included form
Form works.

» To test the new relational form:

1 Choose User in the Use menu.
4D takes you to the [Albums] table.

2 Display the List of tables dialog box (if not already displayed).

In the User environment, you can use the List of tables dialog box to
“jump” to any table in your database. Here are the shortcut keys to
present the List of tables dialog box:
EEEEE

v Design Chi+r

Platform To present the List of tables dialog box

Windows Hold down the Ctrl key and press the Space bar
Macintosh | Hold down the Command key and press the Space Bar
3 Click the word Musicians to go to the[Musicians] table.

You jump to the [Musicians] Output form. 4D lists all the records.

Musician Name I‘r‘earofElir‘th |Country of Birth |‘r‘ear[:|
Johnny Mathis 1935 USA L
Boston Pops Orchestra 0 usa

Lionel Hampton 0 uUsa

Nat King Cole 1918 USA

Stylistics 0 usa

B. B. King 1925 USA

Carpenters 0 usa

Various 1}

Berliner Philharmoniker 0 Germany

Temptations 0 usa

Benda Musicians 0 USa

Gladys Knight & the Pips 0 uUsa

Michael Jackson 1958 USA

Smokey Robinson 0 usa -
A ﬂJ

4 Double-click the record for Nat King Cole.

Musician Mame |Year0fElir1h ICountry af Birth |Year[;|
Boston Pops Orchestra 0 uUsa J
Lionel Hampton 0 usa
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The [Musicians] Input form appears.
Note the included area subform showing the album information.

@ Entry for Musicians H=]
=

Musicians

4o0f21

Musician Name |Nat King Cole

Year of Birth I 1918

Country of Birth [USA

Year Deceased 18645

Motes Born and raised in Montgomery, Alabama.
Formed the Mat King Cale Trio in 1939,
s0ld 50 million records for Capital
Records. generated more revenues than LI

-

Album Title

Format

Mat King Cole's Greatest Love Songs

cD

Music Category i|
Easy Listening

e e = | i1

il

Adding a Record in  You can add more album information for this musician, using the
the Subform [Albums] subform in the [Musicians] Input form. Remember, you
associated the [Albums] Input form with this subform.

» To add another [Album] record:

1 Double-click on a blank line in the included area subform.
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The [Albums] Input form appears.
Note that the musician’s name is already entered in the form.

@Enlly for Albums M= =
Albums B
Cancel T Ut
button ﬁ Album Title |
@fj(t:teopr: g Musician [Mat King Cole
ﬂ Format |
E Music Category |
1 Year Recorded | 0
Q Date PurchasedIDDIDDIDD
ﬂ Purchase Price | ]
@ Notes ;I
7} o
@J Performed by |
Il 27
2 Enter the following data.
Field Name Data
Album Title Nature Boy
Musician Nat King Cole (tab through this field—it is already
there)
Format LP

Music Category | Easy Listening

Year Recorded 1951

Date Purchased 2/1/96

Purchase Price 13.50

Notes

Performed by
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Cancel
button

Accept
button

Accept
button

The [Album] Input form now looks like this:

Albums =
10f 1
Q Album Title |Mature Boy
@ Musician [Mat King Cole
E Format W
E Music Category Im
—— | Year Recorded 1951
@ Date Purchased |02/01/96
ﬂ Purchase Price W
@ Notes =
T o
@J Performed by |
=l A7

3 Click the Accept button.

Clicking Accept saves the new [Album] record. 4D brings up a blank

record for you to continue entering data.

4 Click the Cancel button to return to the main [Musicians] Input form.

Both albums are now listed in the subform.

ji| Entry for Musicians A= E
Musicians
10of2
5' Musician Name|Nat King Cole
@ YearofBith [ 1418
ﬂ Country of Birth [US4
@ Year Deceased 18645
— Hotes Born and raised in Montgomery, Alabama. &
ﬂ Formed the Mat King Cale Trio in 18349,
— s0ld 50 million records for Capital
ﬂ Records. denerated more revenues than ﬂ
@ Album Title Format Music Category ﬂ
— Hat King Cole's Greatest Love Songs CD Easy Listening
@ Mature Boy LP Record Easy Listening
ki
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What's Next?

Summary

5 Click the Accept button in the [Musicians] Input form.

The record is saved. You return to the [Musicians] Output form.

Now that you have the basics, we will expand your knowledge. In the
next chapter, you will learn to use some of the advanced features of
4™ Dimension to create your own customized reports, labels, and
charts.

Congratulations! In this chapter, you have learned how to:

Create a [Musicians] table to store information about musicians.
Define a relationship between the tables [Albums] and [Musicians].
Use several advanced options of the Form Wizard.

View and edit data from both tables on the same form.

If you want to take a break before going to the next chapter, be sure to
Quit (Exit) 4D before turning off your computer.
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and Graphs

Estimated time to complete: 30 minutes

One of the purposes of every database is to generate reports. In this
chapter, you will learn how to:

= Create a list of your albums, using the Quick Report Editor.

= Print labels for your album collection, using the Label Wizard.

= Create two and three-dimensional charts to see how much you have
invested in your collection, using the Chart Wizard and 4D Chart.

Creating a Quick Report

Now that you have a database of your album collection, you want to
print a report list of your albums. You do so using the Quick Report

Editor.

» To get to the Quick Report Editor:

1 Display the List of tables dialog box (if necessary).

"' usicians

In the User environment, you can use the List of tables dialog box to
5 BE abums -

“jump” to any table in your database. Here are the shortcut keys to
present the List of tables dialog box:

Platform

To present the List of tables dialog box

Windows

Hold down the Ctrl key and press the Space bar

Macintosh

Hold down the Command key and press the Space Bar
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2 Click the word Albums to go to the [Albums] table.
You jump to the [Albums] Output form. The form lists all the records.

L M
m - Musician Music Ci;l
Musicians brican in Paris George Gershwin Classics
Lionel Hampton Jaz
| ove Songs Mat King Cole Easy Lis
Stylistics, The Soul
Equested Songs Johnny Mathis Easy Lis
B. B. King Blues
. |[pt Hits Carpenters, The Easy Lis
H b Collection Warious Jazz
Wituoso - Ludwig Y¥an Beethowven Betrliner Philharmoniker Classics
Temptations 25th Anniversary Yolume |l Temptations, The Soul
Brahms Piano Quintet- Clarinet Quintet Benda Musicians, The Classics

. Chl+R
Labels... Ctil+)
Chartz... Chil+k

3 Choose Quick... in the Report menu.
The Quick Report Editor appears.

@ﬂuick Report Editor
Select the fields ——— selectthe fields: Sort order: Cell —— Column
area [ Album Title B =l
/4 Musician
+J| Count
Sort Order - g Format 2 .
area O /% Music Category ;I hin = | Sarted

0 2% vear Recorded
O & Date Purchased 21 s r Repeate.d
Cell Summary 005 Furchace Price Faum I | Auto T
area O B rotes

O /4 Performed by

m Average
Column Attributes

area = |
=
Header
Detail
. Total

Report design ———+—

area - ,,,,513....10&...15&..20&..25&..snu..35&...40&...45&..5Dujd
| F

The Quick Report Editor is divided into five areas.
= Select the fields area
= Sort area
s Cell summary area
s Column attributes area

= Report design area
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Creating a Quick Report

Building the Report Let’s say that you want to print a report that contains the following
fields: Album Title, Musician Name, Music Category, Format, and Pur-
chase Price.

» To build the report:
1 Double-click the field Album Title in the Select the fields area.
2 While the column is still highlighted, click the Sorted check box.
3 Double-click the following fields to add them to your report:
Musician, Format, Music Category, Purchase Price.
As you double-click each column, it is added to your report. Your
report now looks like this:
|=4] Quick Report Editor
Selectthe fields: Sort order: el ———— Column
0 /% Album Title ;I [Albums]Album Ti & !
/% Musician
O /2 Format E Gount
D % st Category ¢ win I~ sorte
ear Recorde
OB Date Purchased ﬂ Il [~ Repeated Yalues
Y& Purchase Price £ sum -l
0O B Notes
0O /% Performed by EI EYEEES
= =
[Albums]Album Title | [Albums]Musician | [Albums]Format | [Albums]Music Category JEUIN S ST e FLE <
Header |Album Title Musician Format Music Category
Detail
Total
L..nan, L, ann L, as0 L, 200 ., 2480 . 300, 350, . 400 . . 450 .
Ki N 3

4 Click the Scroll Bar right arrow or expand the window so you can see
the column Purchase Price.

The Purchase Price column should already be highlighted. If it is not,
click at the top of the column to highlight it.
5 Click the Sum button in the Cell Summary area.

—Cell

!I Count
#¢] win

2' [IE=S
Sum button ————- £ gum

EI Average
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6 Choose Print Preview in the File menu.

The Print Preview window appears.

Stop button

B

Magnifying Glass ——
button

Fel e

lbum Tike

Marsic@n

Ead
Best of E. B. King
Besl of Slodys Knigh. & he Pips. 1973198
Branms Pana Duin, - C Bring Quind.
Carpaniars - Thair Graglasl Hiz
Daubk Goad Everything
iEellin’ Bamdy
dazris Magazine fpril 1933 Callkedian
ahany Malhiz. 16 Mast Requasied Sangs
Lahnmy Manis: In The Sl Y The Hight
Kinal & Tha {Zang Spin Thair Tap Hiz
Lucilke and Cihar C rics by Kenny Rogers
Ha, King Cak's Grastas Lave Sangs
Hatare Bay
R amsady in Blue. An Amarican in Parfs
Sasanfar Lave
iSaund of Jazz
Tam paliams Z3n Aankgrsany valume Il
The Besl of Lhe Bylislics
Tha Lang Flun

M - Ludwig ian Bedthaven

hingy Hausian

Wicrmel dactsan

E. B. King

Bhadys Knight & the Pips.

Benda Muziciams. The

Carpanar:. The

iSmatsy Fabiman

Tam patiam:

Aigriaus

dannmy Malhiz

dahnmy Malhis

Vaal & The Gang

Vanny Ragars

e, wing Cale

Ha, King Calke

Eearge Gers win

Landan Sym phary Crchasle

Liana| Ham pan

Tam patiams. Tha

Sylilice. The

Eagkes

Berlingr Phillarmanitar
hinay Haustan

7 Click the Magnifying Glass button if you want to examine the report
closely.

8 Click the Stop button.
4D returns to the Quick Report Editor.
If you want to print this report from time to time, you could save this
report and use it again. To print the report, you would simply load the
report design and print it again. The printed output would reflect any
changes you had made to the database in the meantime. For more
information, refer to the 4/ Dimension User Reference Manual.

9 Choose Close in the File menu.
4D returns to the [Albums] Output form.
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Printing Labels

Cil+R
[T
Charts... Clrl+k

Label tab

Labels Page
tab

Your next project is to create labels for your CD collection. Perhaps you
noticed that some of the plastic cases were cracking, and you think
that they take up too much room. You want to move your CD’s into
vinyl covers and soft plastic envelope pages. To keep track of the
albums, you decide to print labels for the envelope pages.

Each label will contain the following information:
Album Title

Musician

Music Category

You can quickly and easily make these labels using the 4D Label
Wizard.

To get to the Label Wizard:

Choose Labels... in the Report menu.
The Label Wizard appears, with the Label tab in front.

Labels : Albums

Label ILa UUlI
List ol Felds Ih S|O]o|N | 2wt =H 5| 3] =] e o
T
: Musician Align
b /% Format L fg
>ﬁl’ Music Category . eft
>2E' ‘Y'ear Recorded ICon
’@ Date Purchased
i 02 Purchase Price
- Notes Label
i /8 Performed by | _J .
Design
Static: Text B
area
|
- Dbject Look, Text Style
,_ Backgroun m Border Farmat: I 'I ¥ Plain
— Line width
,i Foreground D Fill Font: . I : j' :: i:;r
Form lo use Font Size: 9 Paints = lhaeine
’V|No Farm ;I Jugtifization: IDefauIt - I~ Outline
Default Lok | Load... | Save.. | Cancel | Print I
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Setting Alignment Before you put any objects on your labels, you need to set your
Options alignment options so that you are working with the correct size label.
To set the alignment options:

1 Click the Layout tab in the Label Wizard.
The Labels Page window appears:

Labels : Albums

Layout
tab Label Lapout |
Orientation Order Click on the
Starting Label. 1 2
=)
Labels across: I 2 ﬁ T ]
Labels down: I 7 ﬁ 3 4
* Label Size ! Page Size
[ Automatic resizing 5 6
Top Margin: g
Left Margin: il
Label width: 255 7 8
Label Height: 113
Haorizantal Gap: i} 3 10
Wertical Gap: 0 .
Unit: m 11 12
Labels per Record: |1 vl
Standard Code: | ;I 1z 14
Methad to apply: |N0 tethod =1
Apply once: ' per Label & per Record
Frint Setup... | Load... | Save.. I Cancel | Frirt I

This window gives you every alignment option you need in order to
print any label on any printer.

In our example, we will print Avery™ 5160 labels. These labels are
1” high by 2 5/8” wide, and there are 30 labels on a sheet.
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2 Starting from the top of the window, set the following options:

Option Setting

Orientation Portrait

Labels Order Left to Right

Labels Across 3

Labels Down 10

Label Size On

Page Size Off

Automatic resizing |Yes

Top Margin 40

Left Margin 26

Label Width Let the Wizard set this automatically.
Label Height Let the Wizard set this automatically.
Horizontal Gap 28

Vertical Gap 0

Unit Point

Labels per record 1

Standard code (Leave blank)

Method to apply No Method

Apply once per record

Your settings look like this:

Labels : Albums

Label Lapout |

Drizntatian Crckr Clck on the

] =) Starting Label. ] [ } [ ]

H = 1 z 3
Labelz acioss: I 3 ﬁ “ ] [ s } [ B ]
Labels davn: | 10
% Label Size ) Page Size 7 ] [ ] } [ 3 ]
¥ Automatic resizing
Top Margin: 40 o ] [ " } [ 12 ]
Left b argin: 26 . ] [ 4 } [ 5 ]
Label Width: 173
Label Height: 73 16 ] [ 17 } [ 18 ]
Harizontal Gap: 28
Vertical Gap: 0 1 ] [ = } [ i ]
Unit: IF'oinl = l 2 ] [ 23 } [ 24 ]
Labels per Record: |1 - I ] [ } [ ]

23 26 27
Standard Code: I 3
Method to apply: |N0 Method ;I 28 ] [ 28 } [ a0 ]
Apply once:  perLabel % per Record
Frint Setup... | Load... | Save... | Cancel | Frint I

Now you are ready to actually design the labels.
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Designing the
Labels

Printing the Labels

N

AN L AW

>

To design the labels:
Click the Label tab to go back to the Label design page.

Drag the field Album Title so that it is positioned near the top of the
label in the label design area.

Drag the field Musician to the label.
Drag the field Music Category to the label.

Choose Select All in the Edit menu.

Click the Align Left icon.
Your label looks like this:

s

[Albums]Album Title
[Albums]Musician  :
[Albums]Music Category

Choose Times in the Font pop up menu.

Text

Format: | E3|
Fant: | Tirmes E3|
Font Size: Im
Jugtific:ation: m

Click Left in the Justification pop-up menu.

For this tutorial, we will just preview the page of labels on screen.

To print the labels:
Click the Print button.

In your operating system’s Print dialog box, check to make sure that
the Preview on Screen option is selected, and then click the Print
button or OK.
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Stop button

The page of labels is previewed on screen.

OEl ISk

Bad
Iifichae] Fackisor
Sl

EBmbme Pimo Charitet - Clarinet Chairde
Eenida Masiciane, The
Clasgical

Chttin' Ready
Tempitatiotes
Soul

Tobweey Ifathic: Bn The Still Of The Hig
Tobwwey Ifuthic
Ensy Listening

Hat Eitg Cole's Greatest Lowe Songs
Hit Eing Cole
Eney Listening

Seascofor Lowe
Lotdon Symphorey Orchestt
Classical

The Best ofthe Sylistics
Stylictice, The
Soul

Best of B.B.Eing
B.E.Eing
Ehues

Carperiters - Their Createst Hits
Cazperiters, The
Ensy Listening

Taamis Magazine bpril 1995 Collection.
Various

Tamz

Kool & The Gang Spin Their Top Hits
Eool & The Gag
Sonal

Hahre Bory
Hat Eitg Cole
Eney Listening

Sonmd of Tax
Linrue]l Hampton

Tuzz

The Lorgg Fam
Eagles

st of Gladye Enight £ the Tips, 1
Gludys Enight & the Pips
Soul

Double Good Brerything
Smokey Robinson
Sonl

Tokwory Mathic, 16 Mot Requested
Tobwwey Iathic
Ensy Listening

Lucille ard Other Claseics by Ko
Esrpey Rogers
oty

Fhapsody i Bhae, An American in ]
reorge Cershmrn
Clssical

Temptaticrs 25th Srwdrersary Woha
Tempitatiome, The
Senal

Trtaoso - Ludarig Vir Beethoren
Eerlier Philharmorer
Clssical

3 Click the Stop button to return to the [Albums] Output form.
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Graphing Your Data

Creating a Pie Chart

Data selection

The 4D Chart Wizard enables you to examine your data with charts
and graphs, using the built-in 4D Chart Plug-in. Let’s take a look.

To get to the Chart Wizard:

Choose Charts... in the Report menu.
The Chart Wizard appears, showing the Chart type tab.

Let’s start with a simple, two-dimensional pie chart.

To create a pie chart:

1 Click the 2D Pie Chart button in the Chart Type tab.
Chart Wizard
Chart type | Chart style | Data selection
ttype | Ch ttyllDtIsl tion | 2D Pie Chart
button

tab

2D Column—T DL ne——p—
a

[3D Surfac.

‘You heed to select some data.

2 Click the Data Selection tab.
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The Data Selection window appears.

Chart Wizard

Chart type | Chart style  Data selestion |
Select D ata for Building the Chart:

Source Table:

| &lbums =l = Use Datafiom Clipboard

Select Fields from the T able : Cateqgory [¥ Auig]:

Album Tite = Data areas
F;EE?” Walles [£ Auig]:

Music Categony |

‘Year Recorded
Date Purchased
Purchase Price
Motes
Perfarmed by

Farmula... |

‘r'ou need to select some data.

Cancel | (K I

Since this a two-dimensional chart, note that there are two data areas.

You want to see the relative size of your investment in each category of
your music collection, i.e., the percentage in Easy Listening, in Rock, in

Soul, and so on.

3 Double-click the field [Albums] Music Category.

4 Double-click the field [Albums] Purchase Price.
Your choices are entered into the data areas:

Chart Wizard

Chart type | Chart style  Data selection |
Select Data for Building the Chart:

Source T able:

|Albums |l [T se Data from Clipboard
Select Fields from the Table : Categary [ Axis]: |7
Alburmn Title ;I |[AIbums]Music: Category
Muszician -

Farmat Walues [£ Auxiz):

Muszic Categony |[AIbums]F'urc:hase Frice

‘fear Recorded

Performed by

Formula... |

Cancel | ak. I

5 Click the OK button.
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Your chart looks like this:

1 (cT) o]
File Edit Text Chat Object Databaze
W AN[O[O[[a] =
. . O 30w
B 51ues
W c1a:sica 1
B Ea:y Listening
W jass
W romery
B zock
“ : : "
6 Choose New in the File menu of the Chart Wizard window.
4D — File Edit Usze Enter Querez Beport Special wWeb Server Pluglns Help
menu bar ga| Y@l =S| 2@l =20/R 5l slied sl dis e

1] (cT) M=
File Edit Text Chart Object Databaze

4D Chart

menu bar || [ AlOl©|C| ]

>

4D asks if you want to save the changes to the chart.

I@ Save changes to the 40 Chart document " ''?

.........................

{liontSave Cancel Save

7 Click the Don’t Save button.
We will now create another type of chart.
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Creating a Three- Suppose you want to create a chart of your dollar investment in your

Dimensional Chart  music collection, based on type of music and type of media. You want
to see the total investment in rock videos, rock CD’s, blues LP records,
and so on. Now, you will create a three-dimensional triangle chart.

If you are continuing from the previous step, you have a blank chart
window on your screen.

@ Untitled2 [CT) (O] =]
File Edit Text Chart Object Databaze
N =]
%”K Al~|Oo|o|a| 5
ChartType
icon
KIN v

» To create a three-dimensional triangle chart:

1 Click the Chart Type icon.
The Chart Wizard appears, showing the Chart Type window.

Chart Wizard
Chart type |Ehart stylel Data selectionl
Data selection |
tab 2D Area
3D Surfac:
3D Triangle Chart
button
“ou heed to select some data.
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2 Click the 3-D Triangle Chart button at the bottom left of the window.

Click the Data Selection tab.

The Data Selection window appears. This time it looks different—
because you are creating a 3-D chart, there are three data areas.

Chart Wizard

Chart type | Chart style D'ata selection |
Select Data for Building the Chart;

Source T able:

|Albums

Select Fields from the Table :

=l [ Use Data)from Clipboard
First Categony [ dxiz): v

Alburn Title
tMusician
Forrnat

Muszic Categony
‘fear Recorded
Date Purchased
Purchase Price
Motes
Performed by

B

Second Category [V Axiz) W Group

Walues [£ Axis]:

rou heed to select some data.

Cancel

Tcan

Data areas

Double-click the field [Albums] Format.
5 Double-click the field [Albums] Music Cateqgory.
Double-click the field [Albums] Purchase Price.

Your choices are entered into the data areas.

Chart Wizard

Chart type | Chart style  Data selection |
Select Data for Building the Chart:

Source T able:

|Albums

Select Fields from the Table :

=l = Use Data;fiom Clipboard
First Categony [ dxiz): I~

Alburn Title
tMusician
Formnat
Muszic Categony
‘fear Recorded
[1ate Purchazed

TicE

Performed by

;I | [&lbums]Format
Second Category [v Axiz) W Group
| [&lbums]Muzic Category
Walues [£ Axiz):
| [&lbums]Purchase Frice

| o]

Cancel

7 Click the OK button.
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Your 3-D chart looks like this:

|=i| Untitled2 [CT) =] 3
File Edit Test Chart Object Databasze
I REEEE j‘
] —_— ]

O riaszica 1

W iz

B Easy Listening

W ol

M 51

M mock

] Comitry

Note Your chart may look somewhat different, depending on how your
database categories are arranged.

8 Click the Close Box of the 4D Chart window.

The Close Box is at the top left of the 4D Chart window on the
Macintosh, and at the top right of the window on Windows.

4D asks if you want to save the changes to the chart.

I@ Save changes to the 40 Chart documert "7

Cancel Save

9 Click the Don’t Save button.
We return to the [Albums] Output form.

Congratulations! You have created your first 2-D and 3-D charts in the
4D Chart Wizard.

May we suggest that you come back to this tool later and explore on
your own. You will find that, like the other 4™ Dimension Wizards, the
Chart Wizard is powerful, flexible, and easy to use.
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What's Next?

In the next chapter, you will learn how to publish your music
collection on the Web.

Summary
Congratulations! In this chapter, you have learned how to:
= Create a list of your albums, using the Quick Report Editor.
= Print labels for your album collection, using the Label Wizard.

= Create two and three-dimensional charts to see how much you have
invested in your collection, using the Chart Wizard and 4D Chart.

If you want to take a break before going to the next chapter, be sure to
Quit (Exit) 4D before turning off your computer.
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4 Publishing Your Database
on the Web

Estimated time to complete: 30 minutes

In this chapter, you will publish your music collection database on the
World Wide Web. When you have finished this chapter, you will know
how to do the following:

= Create a Custom Menu environment.
= Create web-aware forms.

s Publish the data on the Web.

Creating a Custom Menu Environment

Until now, you have worked in the 4D Design and User environments.
Within a Custom Menu environment, you can use special menus that
you create for special uses in your database. One of the uses of a
custom menu is for publishing databases on the Web.

To publish a 4D database on the Web, you must first create a Custom
Menu Environment that will enable you to list your albums by simply
selecting a menu command. You create a custom menu item in the
Menu Bar Editor; you then create the method for this item using the
Method Editor.
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Creating a Custom

Menu Iltem

86

Tools
Ex=plorer

Funtime E =xplorer
Eind..

Databaze Structure
Meru Bar Editor

List Editor
Passwords
Picture Library

» To create the new menu item:
1 Choose Design in the Use menu.

2 Choose Menu Bar Editor... in the Tools menu.
The Menu Bar Editor appears.

g Menu B ar Editor M=l E3
List of Menu Bars Current Menu Bar
=
rCurrent ltem
Method Mame: |
Drrag & Drop a picture from the Libran.
’_ = | Toolbarn [ [Bold
’_ I Shiorteut |
I_._ i_ AT
- E.tart alEw Froeess I Gitire
= ™ | Shaday
™ | Enahiled
_I Access Privileges: I ;I
pdd | [ oo | pbienu | | EdEn | Beee
L— Add button L— Add item button

Now you can create a custom menu item.

3 Click the Add button in the List of Menu Bars area.
The name “Menu Bar#1” appears in the list.

4 Click the Add Item button.

A text box appears, so you can add an item to the File menu.

5 Type the word “List Albums” to name this menu item.
Now “List Items” is a menu item in the File menu.

6 Click in the Method Name box and type “List Albums”.

Method
Name
text box

Start a New
Process
check box

This associates the menu item with a method, which you will define.
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Creating the
Method

Mew Form... Cti+E
Edit Form.... Chrl+L
Mew Method... Chrl+bd
Edit Method... Chil+F

So far, your screen looks like this:

@it Menu Bar Editor 1 =]

List of Menu Bars Current kMenu Bar

rCurrent ltem
Method Mare: [List Alburns]

Glizzez et dépozez ici volre image depuiz la bibliothéque

l_ I |l Traslar [~ Bold
[ I Sharou [ fiadiz
[ Underline
r itart a Mew Process [ Dutline
e [~ Shadow
I¥ Enabled
LI Access Privileges: |AII Groups ;l
add | Delte | AddMenu | Addlem | Delte |

Now you can define the “List Albums” method corresponding to the
“List Items” menu item you just created.

To create the method for the custom menu item:

Leaving the Menu Bar Editor open, choose New Method... in the
Design menu.

The New Method dialog box appears, so you can name the method.
The default name “Method1” is in the text box.

New Method
a rMethod Type
#)/ Listing ' Flowchart
ridethod Name
ethod1
Cancel | (0] I

Name the method “List Albums”.

The method name must be exactly the same as the method name you
type in the Menu Bar editor.

Click the OK button.
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The Method Editor appears.

@3 Method: List Albums

Method editing | =
area
Tables and
fields list | [
Keywords L Albums + Commands
= | | Ao Tite 4| |[4D Emironment f’
If Musician Arrays
Else Format BLOB
End if Music Category Boolean
Case of Year Recorded Clipboard
: Date Purchased Communications
End case x| || Purchase Price x| ||[compiler hdl
4| ¥l

In the next few steps, you will create a simple, two-line 4D Method.

4 Type “All Records(”

That is, the words “All Records” followed by an open parenthesis
symbol.

5 Leave the cursor inserted (blinking) after the open parenthesis
symbol, and click on the table name Albums in the Tables & Fields list.

4D inserts the table name [Albums].

6 Type a close parenthesis “)” symbol and press Enter (Windows) or
Return (Macintosh).

So far, your method looks like this:

@ Method: List Albums

ALL RECORDS([lbums]; ;I

As you can see, 4" Dimension changed the style of the ALL RECORDS
command to bold, upper-case.

7 Type “Modify Selection(”
That is, the words “Modify Selection” followed by an open parenthesis
symbol.

8 Leave the cursor inserted (blinking) after the open parenthesis
symbol, and click on the table name Albums in the Tables & Fields
area.
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Dpen Database...

LCloze b

Database Properties. .

Page Setup...
Frint..

Eit Design Environment
Quit Ctrl+Q

10

11
12

13

Testing the Method

Design Chil+v
v Uzer Clrl+lJ
Custom Menus  Crl+l

>

4D inserts the table name [Albums].
Type u;*)//
That is, a semicolon, an asterisk, and a close parenthesis symbol.

Press Enter (Windows) or Return (Macintosh).
4D changes the words MODIFY SELECTION to all upper-case.

The method editor now looks like this:

o= Method: List Albums

ALL RECORDS (JAlhurms]) =l
MODIFY SELECTION([Alhums];)

E
Heywords +* Albums = Commands

= | || Atburn Title | || 4D Emvironment f’

If Musician Arrays

Else Format BLOB

Endif Music Categony Boolean

Case of “'ear Recorded Cliphoard

: Date Purchased Communications

End case x| || Purchase Price =] || compiter hd|
e | ¥z

Choose Save Method: List Albums in the File menu.

Click the Close box to close the method window.

The close box is in the upper left on the Macintosh and the upper right
on Windows.

Close the Menu Bar Editor.
Congratulations! You have just created your first method in

4™ Dimension! Now you can go to the Custom Menus environment
and test your application.

To test your new application:

Choose User in the Use menu.

In the User environment, 4" Dimension adds another option to the
Use menu—the Custom Menus option.

Choose Custom Menus in the Use menu.
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The Custom Menus window appears, showing the 4D logo.

File Edit Help
2| [ <] o

Custom Menus
window

4th Dimension - Author: Lavrent Ribardidre
Adapted by Bernard Gallet, @ ACT 54 1965-19099. All vights reserved,

3 Choose List Albums in the File menu.
This is your new menu item.

The [Albums] Output form appears.

Alburn Title [ musician 4]
Rhapsody in Blue, An American in Paris George Gershwin b
Sound of Jazz Lionel Hampton

Mat King Cole's Greatest Love Songs Nat King Cole

The Best of the Sylistics Stylistics, The

Johnny Mathis, 16 Most Requested Songs Johnny Mathis

Best of B. B. King B. B. King

Carpenters - Their Greatest Hits Carpenters, The

Jazzis Magazine April 1995 Collection Various

Beethoven's 4th and 5th Symphonies Beethoven

Temptations 25th Anniversary Yolume Il Temptations, The

Brahms Piano Quintet - Clarinet Quintet Benda Musicians, The

Best of Gladys Knight & the Pips, 1973-1988 Gladys Knight & the Pips

Bad Michael Jackson

K1 Llj

4 Click the Done button to close the Output form.
4D returns you to the Custom Menus window.
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Creating Web-Aware Forms

List &lbums

Chrl+LI
LCustom Menus  Chrl+l

Creating a Web

Aware Output Form

ols
FRuntime Ex=plorer
Eird...

Databaze Structure
Menu Bar Editar
Lizt Editar
Paszwords

Picture Librany

>
1

2

You can publish any 4" Dimension database on the Web. In this

section, you will learn how easy it is to create web-aware forms using
the Form Wizard. Any form that you create using the Form Wizard's
Web-Aware” template will be optimized for display in Web browsers.

First you will create an Output form, then an Input form.

REMINDER: The previous exercise left you in the Custom Menus window. In
order to create the forms, you must first get back to the Structure window in
the Design environment of your database.

To get to the Structure window:

Choose Quit from the File menu.
4D returns to the User environment.

Choose Design from the Use menu.
4D returns to the Design environment. The Structure window appears.

You can now create your web-enabled forms.

To create a web-aware Output form:

Choose Explorer in the Tools menu to present the Explorer window.

Q Explorer M[=]
& Tables = FU”’“SI = Methodsl E Constantsl = Commandsl im Listsl
i Preview 0 Comments
B B Musicians ’W
Album Title s
Musician s
Format s
Music Category | /«
vear Recorded | 3¢
Date Purchased | -]
=| Purchase Price | 02
|l = = Wutput Form =E| Motes
New | [ Edt | | oo | ierianm=cl i e

Click the Forms tab to bring it to the front.
[Albums] should already be selected.
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3 Click the New button.
The Form Wizard appears.

Newrom

@ Iew Farm for Table:

|&lbums =]
Farm Name:

Forrn Type: |Detail Form E3|

Template used:  [Classic B3 I

Avwailable Fields Selected Fields

| Master Table LI ;I

m
E Date Purchased

/% Format

/4 Music Category
/% Musician

MNotes

/4 Performed by

02 Purchase Price
ol f LI LI

Advanced... | Cancel | Edit I Use | Y=

LLEEL

4 Choose Albums in the New Form for Table pop-up menu.
The pop-up may already be set to Albums.

5 In the Form Name: text box, change the form name to “Web Output.”
6 Choose List Form in the Form Type pop-up menu.

7 Choose Web Aware in the Template used: pop-up menu.

8 In the Available Fields list, double-click the following fields, in order, to
add them to the form:
Album Title, Musician, Music Category, Format.
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So far, your selections in the Form Wizard look like this:

@ Mews Form for Table:

|Albums

Forrn Mame: fw/eb Dutput
Form Type: | Ligt Farm ;I

Template used: IWeb Aware LI [elEte |

Available Fields Selected Fields
|Master Table =] Album Title =
7 Album Title ﬂ Musician

Z Date Puchased Music Category

ke Format

/% Music Category

Y
Y
/% Musician QI
=Tl
]

Format

Motes
A4 Performed by
02 Purchase Frice LI LI

=T

Advanced... | Cancel | Edit I Use I’#

9 Click the Use button.

4D takes you to the User environment and displays your new
web-aware [Albums] Output form. 4D saves it as the current Output
form for the [Albums] table.

Lantms: 22022 BEE
| Album Title Musician Musicj‘
Rhapsody in Blue, An American in Paris George Gershuwin Class
Season for Love London Symphony Orchestra Class
Johnny Mathis: In The Still Of The Might Johnny Mathis Easyl
Lucille and Cther Classics by Kenny Rogers || Kenny Rogers Count
Jokinny Mathis, 16 Most Reguested Songs Johinny Mathis Easyl
Sound of Jazz Lionel Hamptan Jarz
Mat King Cole's Greatest Love Songs Mat King Cole Easyl
Wirtuoso - Ludwig Wan Beethoven Berliner Philharmoniker Class
Kool & The Gang Spin Their Top Hits Kool & The Gang Soul
Jazzis Magazine April 1985 Collection Warious Jazz

Whenever you create a new form and click the Use button, 4D
automatically takes you to the User environment and sets the form as
the Output form or Input form, as applicable.

You do not have to be concerned about the width of the form. Any
form that you create using the Form Wizard’s Web-Aware template will
be optimized for display in Web browsers. 4D automatically adjusts the
width of the form to fit a standard Web browser when it publishes the
form on the Web.

Discover 4th Dimension 93



Chapter 4 Publishing Your Database on the Web

Creating a Web
Aware Input Form

untime Explorer

Im
=3
g

[[ms)

m
=
=

Database Structure
Menu Bar Editar
List Editor
Passwords

Picture Libram

To create a web-aware Input form:

Go to the Design environment by clicking on the Structure window or

choosing Design in the Use menu.

Choose Explorer in the Tools menu to present the Explorer window.
A - (1=

& Tables Formsl = Methodsl E Eonstantsl = Eommandsl im Listsl

! Preview O Comments
B- B Musicians ’W

Album Title -

Musician s

Format s

Music Category | /=

vear Recorded | 3%

Date Purchased | &

~| Purchase Price | 02

= [t B I | atrnt B =E| Motes
Perfarmed b s

wew | [EE ] | oeee | Y

Click the Forms tab to bring it to the front.
[Albums] should already be selected.

Click the New button.
The Form Wizard appears.

Newpom

@ Mews Form for Table:

|&lbums =l

| List Form LI
;l elEte I

|W’eb Aware
Available Fields Selected Fields

I Master Table =1 ;I

m
2 Date Purchased

/% Format

/4 Music Category
/% Musician

Motes

/4 Performed b

02 Purchase Price LI LI

o F
[ eat | wse  |re=

Form Mame:

Faorm Type:

Template uzed:

EEEEE

Advanced... | Cancel
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AllFields
button

5

6

7

8

9
i
» |
o]
=N
]

Note

10

Choose Albums in the New Form for Table pop-up menu.
It may already be selected.

In the Form Name: text box, change the form name to “Web Input.”
Choose Detail Form in the Form Type pop-up menu.

Choose Web Aware in the Template used: pop-up menu.

Click the Select All Fields button.

Your selections in the Form Wizard look like this:

@ Mewvs Form for Table:

|Albums B3
Formn Marme: ['web Input
Form Type: | Dretail Form LI
Template used: IWeb Aware ;I [elete |
Available Figlds Selected Fields

IMaster Table =1 Album Title =

w D ate Purchased

£ Date Purchased Format

/% Format _,I Muszic Category

/% Music Category | Musician

/% Musician = Motes

Motes Ll Perfarmed by

/% Performed by «l Purchase Price

07 Purchaze Price T “ear Fecorded e
L

Advanced... | Cancel | Edit I Use | o=

For this tutorial, we will use the form with the fields in their automatic
order. However, if you want to rearrange the order of the fields on the
form, you can do so by selecting a field in the Selected Fields list and
dragging it to a different location in the list.

Click the Use button.

4D saves the form and sets it as your current Input form for the
[Albums] table.
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4D returns to the [Albums] Output form in the User environment.

Album Title Musician ﬂ
Fhapsaody in Blue, An American in Paris Gearge Gershwin
Saund af Jazz Liamel Hamptan
Mat King Gole's Greatest Love Songs Nat King Gale
The Best ofthe Sylistics Stylistics, The
._I ahnm is, 16 Most Reques g I Johnny Mathis
BestofB. B. King B. B. King
Carpenters - Their Greatest Hits Carpenters, The
Jazis Magazine April 1995 Collection Various

11 Double-click an [Albums] record.
Your new web-aware [Albums] Input form appears.

|=i] Entry for Albums M=
=
Albums
Album Title Johnny Mathis, 16 Most Reques

Date Purchased |032/03/90

Format ICD

Music Category |Easy Listening

Musician Hohnny Mathis

Hotes

Performed by |

Purchase Price | 9
Year Recorded | 0 Cancel

) = J.r — button
<l ol @i el 8@l o “
i of

12 Click the Cancel button to return to the [Albums] Output form.
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Publishing a 4D Database on the Web

DOpen Database...

Close Method: List Albums  Chil+'w

Save Method: List &lbums
Bevert to Saved

Chil+5

Page Setup...
Frint...

Exit Design Environment

Gluit

Chil+Q

You are now ready to publish your 4" Dimension database on the

Web. In order to publish any 4D database on the Web, there are three
requirements:

Create at least one Custom Menu.

You have already done this.

Create web-aware input and output forms.
You have already done this.

In the Database Properties window, select the Web Server Startup
option, Publish Database at Startup.

4D did this automatically. If you go to the Design environment and
choose Database Properties in the File menu, you will see that the
Publish Database at Startup option is already selected. Whenever you
create a new database in 4D, that Web Publish option is automatically
turned on.

» To check the Database Properties.

1 Go to the Design environment by clicking on any Design environment

window, or by choosing Design in the Use menu.

2 Choose Database Properties in the File menu, and click the

Web Server | Tab control.

AR AR A A ]

—web Server Publishing

Web Server | Tab Control

Publish Database at Startup
TCP Port: I ai Optlon

= Any IP Address ) Specify IP Address

IP &ddress: I a I ] I 1} ]

Default HTML Path
Default HTML Root: |
Detault Harme Page: |

~Mode
™ Use New Contest Referencing Mode
™ Start without Context

Cancel | 0K I

3 Click the Cancel button to return to the structure window.
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Basic Requirements
of the TCP/IP
Networking
Protocol

4th Dimension
TCP/IP Network
Component

In addition to the 4D requirements mentioned, there is another
requirement in order to publish your 4D database on the Web. You
must install the TCP/IP networking protocol into the operating system
on your computer.

If you are running 4D on Macintosh, Windows 95/98 or Windows NT,
the TCP/IP networking protocol comes as a part of the operating
system. If it is not already installed, you can add TCP/IP to your
configuration at no additional cost.

If your TCP/IP connection is an “Intranet” connection (the computers
are physically on the same network, perhaps within the same
building), you will not need to go through any Internet Service
Provider (ISP) in order to publish the database. You just need to set up
a valid TCP/IP addressing system. This means that you should make
sure that all workstations are in the same Subnet—the first three sets of
numbers in the TCP/IP Addresses are identical.

Here is an example of valid TCP/IP addresses within the same Subnet:

Workstation TCP/IP Address

Web Server 205.178.015.080

Workstation1 205.178.015.199

Workstation2 205.178.015.107

In this case, the Subnet Mask is 255.255.255.0 and the Subnet is
205.178.015.0.

In order for 4™ Dimension to use TCP/IP for networking, the

4™ Dimension TCP/IP Network Component must be installed. The
following table tells you where the TCP/IP network component must
be located.

Platform Location of TCP/IP Network Component

Windows The C:\Windows\ACI\Network

Macintosh Embedded inside the 4D application

If you did a normal installation of 4D (not a Custom install), then the
TCP/IP Network Component was automatically installed.

If you have problems with TCP/IP, refer to the Network Components for
4D Server manual.
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If your TCP/IP network components are set up properly, your TCP/IP
properties windows should look similar to this.

Windows Macintosh
TCP/IP Properties 21} EO=—— 1CP/IP
Bindings I Advanced I DMS Configuration | Connect via Ethernet = Ouse sozz
. . — Setup
Gateway | wINS Configuration IP Address )
Configure: [ Manualy 7] Select Hosts File...

An IP addresz can be automatically azsigned to this computer.
If your netwark does not automatically assign IP addresses, ask
your network administrator for an address, and then type it in

Implicit Search Path:
Starting domain name :

the space below. IF Address: [205.178.15.107 | |
Subnet mask ’W‘ Ending domain name :
' Ohtain an [P addiess automatically Router address: I—‘
' Specify an IP address: ;::;S:r;ao]mams:

Marne server addr.:

|P ddress: 205.178. 15 .107|

Subnet Mask:  |2b5.255 .255. 0

2
Cancel |

Checking Web If you have the TCP/IP Networking Protocol and the 4" Dimension

Services TCP/IP Network Component properly installed on your Web Server

machine, then you will be able to use your data over the Web.
If web services are properly initialized as far as 4™ Dimension is
concerned, the Stop Web Server option in the Web Server menu is
enabled and Start Web Server is disabled. If web services are not set

properly, the Start Web Server option is enabled.

er
Start et Sener
Stop eb Server

Publishing Your
Data

» To access your data on the Web:

1 Leave the database MyMusic running on your Web Server machine,
and go to a second machine that already has a valid TCP/IP
connection to the machine that is running 4D.

2 Launch a Web Browser on the second machine.
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For our example, we will use Microsoft® Internet Explorer. Any Web

browser will work just as well.

3 in the browser, type the 4D Web Server’'s TCP/IP address in the
following format: “http://NNN.NNN.NNN.NNN/”.

The “NNN” characters represent the numbers of the TCP/IP address of
the Web Server. In our example, we are using the address

192.168.92.98.

4 Press the Enter key (Windows) or the Return key (Macintosh).
In the Web browser, the File menu of your database looks like this:

a Menu Bar 1 - Microsoft Intemet Explorer |_ (O] x|
J File Edit ¥iew Go Favoites Help |
&8 0 @ | @ B 3 =
Back Farward Stap Refresh Harme Search  Favortes  History  Channels | Fullse
J Address I@ hittp: /19216892 98/4DHome/ %235 221 442626721 .0 j
File
List Albume
Chut
[
|@ | l_ l_ l_ @ Intermet zone A

5 Click the List Alboums menu item.

The web-aware [Albums] Output form appears:
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isplay Selection: Web Output - Microsoft Internet Explorer

J File Edt “iew Go Favoitez Help |

J - Q9 W a E 9 8|k
Back Farward Stop Refresh Harmme Search  Favortes  History  Channels | Fullse
| tcidress |€] hitp://192.168.92.98/4Dmenu/1-11./%23% 231 442626721.0 =
Album Title Musician ‘I\-Iusu: Format 7
Category
> Rhap?Ody m Blug, A George Gershwin Classical CD
American in Paris
(> Sound of Jazz Lionel Hampton Tazz CD
Drill-down MWat King Cole' E
> at King Cole's Mat King C'al asy oD
button Greatest Love Songs i Listening
[ [ [ [ [ [~ |
|@ | l_ l_ l_ @ Inteinet zone 4

Note how the columns have been adjusted for display in the Web
browser. This is the benefit of using Web-Aware Templates.

6 Click on a record’s drill-down button.
The [Albums] Input form appears.

3 Data Entry: Web Input - Miciosoft Internet Explorer [_ O] ]

J File  Edit “iew Go Favortes Help |

J@.».@ﬁ‘@@

Back Farward Stop Refresh Home Search  Fawortes  History  Channels

Ful
J Address I@ hitpr#/192.168.92. 98/4D disprec/0/%23% 231 4426267211 j

Albuns

Album Title  [Rhapsody in Blus, An Armerican in Paris

Date IW

Purchased

Format ICD
Music IC\assical

1 o
Category

s

Musician |George Gerstmin

Notes Live performance. =

Performed by [Boston Pops Orchestra

Purchase Price I] 285
|@ | l_ l_ l_ @ Intemet zone

=
Y
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Summary

Congratulations! You have published your data on the Web!

For more information about the many options you have when
publishing 4D databases on the Web, see the 4™ Dimension Language
Reference Manual.

Congratulations! In less than two hours of practice, you have
successfully performed all of the following:

Created a relational database to track your personal music collection.
Created custom Input and Output forms to view the data.

Imported sample data records.

Created your own custom queries.

Created a custom report to print a list of your albums.

Designed your own labels for your CD holders.

Printed two- and three-dimensional charts to analyze your collection.

Created a multi-window, custom menu environment for your
database.

Created forms for viewing your data on the World Wide Web.
Published your database on the Web.

If you want to learn about additional capabilities, refer to the other
manuals provided with 4™ Dimension.
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